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* Introduction
— Key Concepts
— Primary Challenges

’ PTC BeSt PraCt|Ce Storyboard It is recommended that the reader has some
— Model Based System Engineering knowledge of SysML

+ OMG SysML Specification -
http://www.omg.org/spec/SysML/1.3/
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PTC Process Landscape

PRODUCT LIFECYCLE
P> Validate p> Produce

WV Organization P Plan » Support

P> Design P> Operate

Project Management
Management Change and Configuration Management
Quality & Reliability Management

Requirements Definition and Management

Concept Development
Software System Architecture Design
Engineering Verification and Valldatlon

Platform Design & Varlant Generation

Mechanical, Electrlcal and Software Development

Product Cost Management

Design and Manufacturing Outsourcing

Regulatory and Materials Compliance

Manufacturing Component and Supplier Management

Manufacturing Process Management

Product Support Analysis and Planning

Supply Chain
&

Warranty and Performance Based Contract Management
Service Diagnostics and Knowledge Management
Service and Parts Information Creation and Delivery

Service Parts Planning and Pricing

Service Logistics and Network Management

Service Order Management and Field Service
Equipment Monitoring and Lifecycle Management

Performance Analysis and Feedback

Sales & Service

Business System Support

Smart, Connected Product Enablement
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PTC Process Landscape

PRODUCT LIFECYCLE

V' Organization P Plan P> Design P Validate P Produce P> Operate P> Support
Management
Hardware & : :
Software System Architecture Design
Engineering

| | Best Practices )

Model Based System Engineering

_ Automated System Design Review

S“pp'BéLCha'” System Model Management

System Model Publishing

Model Based Product Line Engineering
@rchltected Modular Design /

Manufacturing

Sales & Service

‘ Also review the System Engineering Solution

Technical Presentation for additional information
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Model Based System Engineering Approach

« A common process for constructing a SysML system model involves an

iterative approach based around the SysML diagram taxonomy
— Each iteration corresponds to a layer of abstraction of the system and involves the capture of
requirements relevant to that layer, followed by the definition of structural and behavior elements
necessary to meet those requirements
— Work would then progress on the next layer(s) to model sub-systems
— Work within the iteration such as defining the structural and behavioral elements can be done in
parallel

A

_
C D N Layer 1 — Capture system requirements and

\ domain. Define system model for this layer )

™

| 1 < - - <
|£B:| Eéj }I (" Layer 2 — Cascade requirements from
previous layer and refine/derive/decompose.

C 2 \ Iteratively update system model to incorporate
T T T \‘ _ requirements and designs for this layer )
|

\
1
/ Layer 3 — Cascade requirements from
4 previous layer and refine/derive/decompose.

requirements and designs for this layer

This is an example —the
number of layers needed
will depend on the system
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Model Based System Engineering Approach

Considerations

« Atop down modelling approach can produce a comprehensive definition of a
product or system starting from the highest level down, but is not always practical
or realistic

— Abottom up approach should also be considered, where definition of critical aspects or sub-
systems of a product are prioritized

— Middle out is where additional detail is captured at the same level of abstraction
— Often a combination of these approaches works best

4
|/ (o J e JLF]lc] Middleout\|
| . =T |
|
| EnjEm En e o,

Bottom up

© 2015 PTC



Model Based System Engineering Approach

Considerations

« Often customers are looking to improve existing products, so model the parts of the
system they plan to re-use only to the level of detail needed, enabling re-design of
specific sub-systems

« Consider if product variability will be required
— Refer to the Model Based Product Line Engineering storyboard for more information

« Large, complex systems can be managed using the Asset Library, allowing modular
components to be created and re-used within multiple models. Requirements, use
cases and interfaces are cascaded down when assets are re-used.

— Refer to the Architected Modular Design storyboard for more information
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* Introduction
— Key Concepts
— Primary Challenges

« PTC Best Practice Storyboard
— Model Based System Engineering
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Model Based System Engineering Best Practice

Challenge: Designing complex systems within disconnected engineering disciplines

* Practice:
— Enable collaborative complex system engineering using a
common industry standard modeling language

« Capabilities:
— Graphically define product context and stakeholders
— Map and trace from requirements to the design
— Model architecture including system functions and structure

* Value:

— Improve communication between stakeholders and engineering
teams

— Improve product quality by early problem identification and
enhanced design integrity

— Increase productivity by reuse of model elements and improved
impact analysis

— Reduce risk with improved estimation and early requirements
validation
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Model Based System Engineering Procedure Overview  PTC

» Plan Systems Engineering Initiative

_ — mmm—p Establish cross-
- Define objectives, Pid functional team
: /«K scope and process
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Engineer

Plan Systems
Engineering Initiative

I, SE Project CFT
I
I
I

$880

Define & Analyze
System Context

Analyze Requirements

Design Use Cases

Design Functional View

Design Architecture

Allocate Architecture

Refine and confirm e ———
A7

plan

Define quality and
performance
measures and targets

®
=N

I@

l@

Identify re-use
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PTC

Model Based System Engineering Procedure Overview

» Define and Analyze System Context

Capture system domain
information in
consultation with CFT

Create and configure
system model
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Model Based System Engineering Procedure Overview

» Analyze Requirements

-
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Model Based System Engineering Procedure Overview

» Design Use Cases

Define use cases and
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Model Based System Engineering Procedure Overview  PTC

» Design Functional View
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Model Based System Engineering Procedure Overview

» Design Architecture
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architecture design

Design Use Cases
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Define constraint
blocks and parametric
diagrams

fc

«constraints»
FlowConstraint

constraintParameters
«ConstraintParameter» demand : Real
«ConstraintParameter» flowrate - Real
«ConsiraintParameter» pressure - Real

constraints
{Tlowrate=pressure(4*demand)}
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Model Based System Engineering Procedure Overview  PTC

» Allocate Architecture

Allocate system behavior Map system architecture to mechanical,
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Model Based System Engineering Best Practice

Procedure

» Plan Systems Engineering Initiative

€) GLF

System
System Engineering
Engineer CFT / Project

Manager

Plan Systems
Engineering Initiative

Define & Analyze
System Context

Analyze Requirements

Design Use Cases

Design Functional View

Design Architecture

Allocate Architecture

I@

ls lg

H

* Objectives
— Define a plan for the systems engineering program, project or phase

* Role
— Project/Program Manager
— System Engineer
— Cross-functional Team

e Qutputs

— Plan for the systems engineering initiative covering objectives, scope,
process, constraints, domain, resources, re-use opportunities and
quality/performance measures and targets

© 2015 PTC
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Model Based System Engineering

» Plan Systems Engineering Initiative

Engineering
CFT / Project
Manager

Engineer

Plan Systems
Engineering Initiative

Define & Analyze
System Context

Analyze Requirements

Design Use Cases

Design Functional View

Design Architecture

Allocate Architecture

I@

ls lg

H

Define Objectives, Scope
and Process

@ Establish Cross-
functional Team

Capture Constraints

@ Define Quality and
Performance Measures

and Targets

S
Identify Re-use

Candidates

¥
@ Refine and Confirm
Plan
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Model Based System Engineering

» Define Objectives and Scope

Engineer

Engineering
CFT / Project
Manager

Establlsh Cross-
functlonal Team

Capture Constralnts

Define Quallty and
Performance Measures
and Targets

@ Identify Re-use
Candidates
e
Refine and Confirm
Plan

There are many different starting points for a Systems Engineering initiative:
— Development of a new product or product platform

— Adapting existing product or platform
— New requirements or regulations

Therefore it is important to coordinate with related disciplines and processes

FRUDUL LIFI:\.M

- Design P Validate P Produce

Locate and verify any existing requirements,
objectives, scope, domain, process,
—] constraints, performance measures/targets

P Plan |

Program and Portfolio Management
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Project Management
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Change anmmem
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—
Variant Design & Generation
Y

Product Cost Management

Desi mutsouming

Compon BI‘II.’:{I‘IdSI.IppliTI‘IEgEmEM
Man qucassMamtgement
Tooli mu re

ents Definition and Management
Product Support Analysis_and Planning
Service and Parts |
Service Information Delivery and Field Knowledge Manageme:
Equipment Lifecycle Management
Service and Parts Order and Delivery
Performanc Nﬂysis
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Model Based System Engineering

» Define Objectives and Scope

@@3 In coordination with other processes, defm_e dra_lft objef:tlves, Source: INCOSE, Wikipedia
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.._____.‘_______'

! Establish Cross-
functional Team
(8 \ b - Rk s S =
Capture Constraints _ _
Refer to PTC System Engineering Process Governance

Process library maturity

‘ practices for guidance on lifecycle process , PTC M
@ Integrity Process Perspective and Process Director /

2 definitions accessed this month

Define Quality and

Performance Measures w o | s
and Targets mz—

v
@ Identify Re-use PTC Integrity" Process Perspective
Candidates
Refine and Confirm : e
1@9 OBJECT MANAGEMENT GROUP
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Model Based System Engineering

» Establish Cross-functional Team

System
Engineering
CET

System
Engineer

Capture Constralnts

Define Qualrty and
Performance Measures
and Targets

@ Identify Re-use
Candidates
e
Refine and Confirm
Plan

Ensure representatives from all affected
departments are members of the cross-
functional team. This may include:

Marketing / Sales

System Engineering

Software / Electrical / Mechanical
Engineering

Manufacturing

Service

Additional input may also be
obtained from external parties such
as suppliers, partners, regulatory
agencies and customers but these
are not part of the core CFT.

© 2015 PTC
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Model Based System Engineering

» Capture Constraints

Confirm constraints

System
Engineering
CEIl

System
Engineer

such as regulatory
compliance and

company or industry
standards

Define Objectives, Scope

and Process
Include any known

engineering limitations

Establish Cross- or constraints

functional Team
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A completed PTC Creo solid part gives designers unmatched capabiltity to update and/or modify complex

PTC Mathcad

Ato Z | About this site | Contact | FAQ | Sitemap| Search | Legal notice |

ENVIRONMENT

European Commi

Home About us Policies Funding Legal compliance

Restriction of Hazardous Substances in Electrical and Electronic
Equipment

ROHS 1 (repealed 3 January 2013)

» Directive 2002/95/EC of the European Parliament and of
the Council of 27 January 2003 on the restriction of the
use of certain hazardous substances in electrical and
electronic equipment. Consolidated version(status after

Batteries » Commission Decision 2010/57 1/EU and Corrigendum).
Eribr s s b « Directive 2008/35/EC of the European Parliament and of
the Council of 11 March 2008 amending Directive
VCV:’;:"“’“"" T 2ETETET 2002/95/EC on the use of certain hazardous substances B
in electrical and electronic equipment (ROHS), as regards
RoHS in EEE @ the implementing powers conferred on to the
\ntrodudtion Commission.
Leaisiation ROHS 2
Studies L « Directive 2011/65/EU of the European Parliament and of a8
Activities 5 the Council of & June 2011 on the restriction of the use
G of certain hazardous substances in electrical and electronic equipment (recast).
Useful Information )| Secondary legislation on RoHS 2
" 22004 000.001 1
WEEE g Exemptions o e
End of life vehicles (ELV) 3 » Commission Delegated Directive 2012/50/EU of 10 October 2012 amending, for the purf e co i contents
I technical nroare: Annex I11 to Directive 2011/65/FU of the Furonean and
»B COMMISSION DIRECTIVE 2004/104/EC
of 14 October 2004
adapting to technical progress Council Directive 72/245/EEC relating to the radio interference
(electromagnetic compatibility) of vehicles and amending Directive 70/156/EEC on the approxima-
tion of the laws of the Member States relating to the type-approval of motor vehicles and their
trailers
(Text with EEA relevance)
(OJ L 337, 13.11.2004, p. 13)
Corrected by

»Cl Comigendum, OJ L $6, 2.3.2005, p. 35 (2004/104EC)

Also consider business constraints
such as project deadlines and
milestones, or release/sales schedule

© 2015 PTC
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Model Based System Engineering

» Define Quality and Performance Targets

GO

Coordinate with Quality Mgmt processes and
define quality and performance measures
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Model Based System Engineering

Consider existing SysML models
for similar products

» |dentify Re-use Candidates

Identify re-use candidates fna ,
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ckage] HSUVARalysis [Defintion of Dymamics) (H

Establish Cross-
functional Team

me Admin: { Log.Qut ] Project: UAV Systems Design Home Admin Options Help

Define Quality and If using the Asset Library, ]
Performzn{:e Me{asures evaluate any existing e — E
and targets components or assets that R R T .
may be re-used. Refer to the EE
Identify Re-use 1 Architected Modular Design
Candidates Best Practice for more
+ information
Refine and Confirm
Plan
.
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Model Based System Engineering

» |dentify Re-use Candidates

L,

GO

Evaluate existing

1

hb System ; ]
System Engineering mechanical, elt_actncal of
Engineer CFT software designs for
possible re-use

Define Objectives, Scope
and Process

Establish Cross-
functional Team

v

|Actions ~ | [@] Software Build - 0000000061, NVIDIA_GeForce 70200 _Drivers_Build

Overview | Details ||| Structure ||| Content Traceability
Where Used | References Documents ‘ Referenced By Documents | Parts ‘ Distribution Targets

= References Documents Default

~-DE®mD
Number 17 Version 1 Name Context
\@1 00091 Al 1) Config_Nvidia_Graphics_ NVIDIA_Grap

&] 00081 Ad

ﬁeni_Nvdla_Graphcs_(ard NVIDIA_Grag

Existing software designs

—ax

o o

@ Capture Constraints

Define Quality and
Performance Measures
and Targets

s1l
> @ [ AS-1! 6 Graphics
DPCRCHRF oy
1511 E Light Graphics
e

Identify Re-use
Candidates

V- H e
Refine and Confirm | _tE8
Plan b

Existing MCAD
(Mechanical Computer
Aided Design) designs

= Sysem
Dewcription:
Format Name:
Comtext:

Ute Cyde Templat

Crented By:
Creted Owe

Search | Browse

Existing ECAD (Electrical
Computer Aided Design)
designs

© 2015 PTC
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Model Based System Engineering

» Refine and Confirm Plan

If needed update plan objectives, scope,

System process, constraints, CFT, quality and
System Engineering performance targets and re-use candidates
Engineer CFT / Project

Manager

@—

Define Objectives, Scope
and Process

@ Establish Cross-
functional Team
@ Capture Constraints

|

Define Quality and

Performance Measures
and Targets

@ Identify Re-use
Candidates
L e
Refine and Confirm
Plan

Kick off and manage project

..................................

CONCEPT DEVELOPMEN...

OF.

VALIDATION (STA..

CONCEPT
APPROVAL

APPROVE
DESIGNS

© 2015 PTC

/
|
|
|
|
|
|

DESIGNS
VALIDATED

SE Project CFT

&

iz

—-—e e e =

- s s o -

Review and confirm plan
with CFT

o
o

R
A
C
~ff -
"
E
R
|
Cc
A

L
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Define and Analyze System Context
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Model Based System Engineering Best Practice

Procedure

» Define and Analyze System Context

System
Engineer

Plan Systems
Engineering Initiative

]
I
I

Analyze Requirements

Design Use Cases

Design Functional View

Design Architecture

Allocate Architecture

* Objectives
— Capture, document and analyze system domain information

* Role
— System Engineer

— Cross-functional Team

* Qutputs
— System Domain Model

© 2015 PTC
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Model Based System Engineering

» Define and Analyze System Context

System

] Engineering
Engineer

CET

Plan Systems
Engineering Initiative

Analyze Requirements

Design Use Cases

5.0) |

Design Functional View

Design Architecture

Allocate Architecture

Create and Configure
System Model

@ Capture System
Domain in

Consultation with CFT

@ Analyze, Refine and
Update System
Domain Model

et

© 2015 PTC
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Model Based System Engineering

» Create and Configure System Model

hb System
System Engineering
Engineer CFT

Capture System
Domain in
Consultation with CFT

Analyze, Refine and
Update System
Domain Model

Coordinate with related
processes such as
Requirements Management,
Quality Mgmt and identify any
relevant existing information

PRUDULT LiFELTULLE

P Design P validate

Program and Portfolio Management
Project Management

Service and Parts Order and Delivery
Performance Analysis and Feedback

Enabler supports

Select File > Open Sgterple:-Cpenblogel 0 sl coOllaborative model
Model... to open Enabler Lookin:  \\Enabler\POLLERTONL L1\ Examples\Truck System B EEEX 28 develo pment (Setu P
1 12t &% Enzbl A
and review existing o Harme Yesion during Modeler
P Active Deferred Ball Game Bxa... 0
. . 2 Bamples % . o
Repositories and Models ") Avtive Defered BallGame Esarple 0 installation)
. [ c# Another Block (Tetris) Exam... 0

[ C# Another Block (Tetris) Bomple [4] Distributed Ball Game MDA Exa... 0 17
f J[4] Distributed Ball Game MDA Example % z”‘”grj‘at"’" . S 12/117221: Egﬁ

Filling Stati eart Monitor 5231
% H‘E::lgM:H‘:;r c % Heart Monitor Java 0 .. 08/09/2014 15:22:33
i £ Heart Monitor Java HSUY 0 12/12/2014 11:24:08
Edit View Tools Diagram Window Help L & HSuY [4] Search and Rescue 0 UK-CHE-DTP-022\... (08/08/2014 15:22:39
—— rch and Rescus 2] Speed Controller 0 UK-CHE-DTP-022\.. 08/09/2014 15:22:41
Speed Controller £) Template - Component-based ... 0 UK-CHE-DTP-022\.. 08/09/2014 15:22:41
Od El... @ Template - Component-based Products @ Template - Incremental Process 0 UK-CHE-DTP-022\... 08/09/2014 15:22:41
[£] Template - Incrementsl Process 4] Template - Small Project 0 UK-CHE-DTP-022\.. (08/09/2014 15:22:42
Close Model 4] Template - Small Project £ Traffic Lights 0 UK-CHE-DTP-022\... 08/09/2014 15:2243
4] Traffic Lights [&] Traffic Lights - SySim 0 UK-CHE-DTP-022\...  08/09/2014 15:22:45
Model » -[4] Traffic Lights - SySim & Truck System 4 PTCNET\Pollerton  26/12/2014 17:13:27
4] Truck System ) [£ VB Another Block (Tetris) Exam... 0 UK-CHE-DTP-022\...  08/09/2014 15:22:45
View Log » &) VB Another Block (Tetrs) Ecample [£) Waste System 0 UK-CHE-DTP-022\.. 08/09/2014 15:2335

A& Waste System

£4 Models

[& PJO_Sys_Eng 01

< 0

If using Asset Library, this
may be a collection of
linked models for systems
and sub-systems

Truck System

™ Version: 4
Last Changed By: PTCNET Pollerton
Last Changed On: 26/12/2014 17:13:27
Last Operation:

Created By: PTCNETVPolerton

Created On: 12/12/2014 15:34:34
Attributes: RWO
Comment:

© 2015 PTC
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Model Based System Engineering

» Create and Configure System Model

@Qa Notify those involved in the modelling

Vis, YO activity which mode|(5) and version is it Changed On Last Operation Created By Created On
System being used and how to access Fe—— W g

System Engineering -

Englneer CFT Edit access permissions for:  Truck System version 5

|&) 1rathic Lights - Sy5im
m Truck System

U UK-CHE-D I P-DLEN,., DU ULE 122840
PTCMET\Pollerton  26/12/2014 17:13:27

This dialog sets permissions for the model ONLY. Use Artisan Studio if you
want to copy these permissions to packages in the model.

MName Access Rights
PTCMET\Pollerton Owner

L —— .
Access permissions on / '
models can be defined

Public Write Public Read

Users whose license package does NOT support access permissions:
Capture System

May only open models where the model public read flag is on.
Mav onlv write to models where the model oublic write flaa is on.
DL FE e Voo Sased Suste el e ) (o ) (o) (s
Consultation with CFT e e e e—
OlEl@] lEm Dlw|]0]x] dla|F]E|s] =lHn] bk T
| Models - Datastore details
Analyze’ Reflne and '%ﬂé::f:lﬁ ] gaf:émm | General Files and Directones |op.mﬁnm Parameiers )
Update System el FodERTET == —— | Repositories can be
Domain Model Aot s managed using the
2 | ——— Repository Administrator
Fiecoany Log File: Size

[D\PTC‘\,MisanSIudinEl_'l\Enahlm\EnnhlﬂBuckhp |'IZI]IIII]

Seve Dewvice: |C WPTChArsanEudiod] 1\ Ensblert EnablarBackup

Festons Lag File: |C APTCLAR=enSdicl _1\Enabler\ EnablerBackup.

Attibute ;_ TEnata E b A TFas P
Fila Direclonies [
5 I
Refer to System Model
£l hidp Management Best Practice
for more information
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Model Based System Engineering

» Create and Configure System Model

System

] Engineering
Engineer

CET

Capture System
Domain in
Consultation with CFT

Analyze, Refine and
Update System
Domain Model

Select File > New Model to
create new system model

If needed, import the SysML
Profile (Tools > Add Profile)

\
Mew Model...

= .

Options:

[V 3 umL
Systems Engineering

i MERE

4Simu|ink

Provides stereotypes and tag definitions that are defined in the LML

Configures Studio so that you can model MBRE diagrams and items i

Required by the M

. SysML (Full Profile)

Select Options — choose SysML
(Full Profile) and enter name

| &# SysML (Requiremerts Only)
System Architecture
TDK Code Generators
[T ARINC 653 for PikeO5 653
[ BB ARING 653 for VicWiorks 653
a8 1 g
Eic

I
P |

A subset of the SysML Profile that allows you to model SysML Requirements in your model.
Required by the System Architecture Migration Utility.

Allows you to build ARINC 653 generators using TDK.
Allows you to build ARINC 653 generators using TDK.

Allows you to build Ada generators using TDK.
Allows you to build C generators using TDK.

L

Repository:  “\Enabler\POLLERTOM1L1%Examples

s —

Model Name:  Truck System

| Enable Change Tracking

Help

0K J[ Cancel |

Profile extensions can be used to support a
customer specific data model

© 2015 PTC
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Model Based System Engineering

» Capture System Domain in Consultation with CFT

Navigate to the Packages view,

e @@3 ! Packages v 1 X right click on the Truck System
A * - and select New > Package
System = [} (-
System Engineering -\‘i: SUML Reinitialize Profile Helper
Engineer CFT .
"ﬁ. +SysM Start Link
-§8 +Ateg{  End Link..
Report 3
| New r Package
Create and Configure | Update All Profiles... Change Note®
System Model 1 Diff With Nther Madsl Comment
pp—— A ——— | Packages . .
L : =i i System. Enter a suitable name Can be renamed easily by
Capture System | -0 +UML Profile for the package selecting the item and
Domain in ] "?.. +SysML Profile Changlng the Name field mm TRLEYY LIS T IS
] Consultation with CFT 288 +Atego Utilties Profile value =0 +Truck (SysML)
1 - +Truck Domain : 5.0 +Activities
ey [  Packages N/
2 naiyze, Refine and S =P
nalyze, nefine an _ . -0 +UML Profile - +Bloc
Update System (& Packeges [ @B @ [E Rl [ «» - +SysMIL Profile -1 +Diagrams

f ; S = -85 +Atego Utilities Profile
: Properties of ‘Truck Domain :
Domain Model P S o

General |Te=xt | Options I Changes | Style | ltems | Access PelTI'I.iSSiOI"IS| D +Jse Cases
l_l_l_r -] xVariation

CI Truck Domain Q Packages "'_h @ € i AA

Properties of 'Truck (SysML)' _/ \

D +Requirernents

Fullname:  Truck Domain

General |Text | Options [ Changes | Style | Additional packages can
Type: Package be created to structure
Last changed on/by: 30/12/2014 10:20:43  PTCNET Palletton D Truck (SysML) and organize model
Vigibilty: @ Public ) Protected  (0) Private  (C) Package Full name:  Tryck {Sy=ML) elements

T -
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Model Based System Engineering

» Capture System Domain in Consultation with CFT

€) GEE

System
System Engineering
Engineer CFT

Create and Configure
System Model

I

1
Capture System |

Domain in 1
1 Consultation with CFT :

L

Analyze, Refine and
Update System
Domain Model

58 +Atego Utilities Profile

@

Start Link
End Link...

Right click on a package and select New >
Diagram > SysML > Block Definition Diagram

| Mew

Package

—— 0@ BB X oS
P[22 7D A &4 oD ol =5 [ B o 56%

Update All Profiles... Change Mote

Diff With Other Model... Comment

Remove from Package Constraint

Links \ MatrigTable  » IUML N R T T
! File Edit View Tools Diagram Window Help

|0'°'|@ i@&|Environment =
- BEg] R BE® 0O

Variability —»

Package Diagram

NN

i Packages

-

New diagram created
within the new package

E—
[Package] Truck (SysML) [1] X

E@ Truck System.
-5 +UML Profile
4% +SysML Profile
w-8% +Atego Utilities Profile

(Carctage REEEE ] «»

Properties of '[Package] Truck (SysML) [1]'

- 0 x
bad [Package] Truck (SysiL) [1] I
Blocks, in SysML,
provide a means of
g n ) describing a system as a

hierarchy of modular

components, each of

General |Tedt | Changes | Style | hems | BlockDefinitionDiagram |

which can have a set of

[Package] Truck (SysML) [1]

structural and/or

Fullmame:  Trck (SysML).[Package] Truck (SysML) [1]

behavioral features

Page reference:  pqq
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Model Based System Engineering

» Capture System Domain in Consultation with CFT

System
Engineer

Engineering
CE

Create and Configure
System Model

Capture System
Domain in
Consultation with CFT

Analyze, Refine and
Update System
Domain Model

Capture all physical entities involved in the system such as users, operators as well as
non-human entities such as equipment, facilities and technology for the user interface

| bdd BDD (TruckDomain))

X
S

| I

Add Blocks to the model to
represent the entities within
the system domain

Driver Fuel Station
Operative

Define Actors that
interact with the
T —

Jl

+ B % i Properties of Truck'

General | Text | Options | Changes | Style [ kems [ Block |
Changed By Changed On .l

Truck

Full mame:  Truck (SysML)::Blocks: Truck

Type Block

il sme BTV -wlo-ole st e ety @
= Blocks are internal to the system
-Block

and actors are external. Blocks
are typically things we can
manage or control

© 2015 PTC
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Model Based System Engineering

» Capture System Domain in Consultation with CFT

: ,', @Qa Define associations between system domain entities
&S Vis, YO
» System

System Engineering Thisis a
Eeer CFT This is a standard association from Composite
the Truck Domain block to the Aggregation
FuelStationOperative actor association

)
\[— —
Create and Confi ! . ; X
reate and Configure

System Model [El BTN N

Drivier Fuel Station
Operative

Capture System i
Domaln In * I X Properties of 'Associates’ N
Consultation with CFT |

i | General | Text | Options | Statt Role | End Role | Changes | Style | tems |

xd By Changed On Name Direction

Analyze, Refine and ® Statend Truck Boman

Update System B End ot Associates
Doma"’] MOdel D Bi<irectional Fuel Station Operative
) None
- [[] Composite Aggregation

2 ofe iy o8- AL )

#— Composite Association
o—  Shared Association
| — Association h |

“U

e — —>I Uni-Directional Aszociation
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Model Based System Engineering

> Capture System Domain in Consultation with CFT

System

1 Engineering
Engineer

CET

Create and Configure
System Model

Capture System
Domain in

Consultation with CFT
1

Analyze, Refine and
Update System
Domain Model

bdd GraphicalBOD (TruckDomain)
Representative —
images can be used )
for diagram entities
[ '
‘l ‘R = | ] i %
1) Load
Driver  FuelStationOperative Truck
!III
Rnaﬂ Air
View Options A — [
Right click on the entity - © et
X i terentypes Stereotype | -]
and select View Options > Y S | |
Edit > Select Image =
Sample

Auu LEs ~
Remowv Favorites  Ctrl+5Sh

e T
=

[ ]
Fuel Station eyl

General | jcon | Cc |
i Undo A d Colors Node Styles Image
g
Bn Copy a Sample Text ground | Defauit Color Used Line Width | Defauit -
EI Pzt a Lines [ Dsfaut Color Used Presertation [¥] Name Ony
) | o [7] Aspect Rt
o] paste syte = | — P e e
ste Sty [Cear Image |
R Delete Del [ Use Defaut Colors ] [ UseDefaut Node Spies |
Rename Fort Flow Styles ‘E! s
L J—
Symbols =] || Linewidih >
Delete from Model ( J :7:
Fresentation -
Criea -

Driver
T Align To Grid
View Options I
Zr| Properties " Alt+Enter

© 2015 PTC

Shadowing |

[ Use Defaul Fort

Use Default Flow Styles

J Sample Text

Clear Al General Siyle Settings
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Model Based System Engineering

» Analyze, Refine and Update System Model

¢ @ =) B -
' ”I“ @6 Conduct areview of the system domain model with the CFT to confirm S
— System that the model accurately represents the domain in focus
System Engineering
Eng I neer CFT bdd GraphicalB DO (TruckDomain),

[0
Create and Configure ﬂ *

System Model o '*ﬁmj\w

Capture System = Update model with any

Domain in changes as needed
Consultation with CFT

Perform analysis to
< confirm model is
complete and correct
- (Refer to Automated
System Design Review
Best Practice)

Analyze, Refine and
Update System

Domain Model @

There may be incomplete information available
at this point so the creation of block and
internal block diagrams should occur iteratively
and recursively as more system and sub-
system requirements are identified. Further
iterations occur in the following procedures
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Model Based System Engineering Best Practice

Procedure

» Analyze Requirements

System
Engineer

* Objectives
— Capture, analyze and refine system and sub-system requirements

Engineering
CE

* Role
® — System Engineer
Plan Syst .
— Cross-functional Team

I
Define & Analyze . Ou’[p uts

System Context _
— Requirements Model

Design Functional View

Design Architecture

Allocate Architecture
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Model Based System Engineering

» Analyze Requirements

System

] Engineering
Engineer

CET

Plan Systems
Engineering Initiative

Define & Analyze
System Context

Design Functional View

Design Architecture

Allocate Architecture

Capture System or
Sub-system
Requirements with
CFT

|

Analyze and Refine
Requirements

}

Confirm Requirements

|

Update and Baseline
System Model

© 2015 PTC

43



Model Based System Engineering

» Capture System or Sub-system Requirements with CFT

€) GEE

System
System Engineering
Engineer CFT

Capture System or
Sub-system
Requirements with
CFT

Confirm Requirements

Update and Baseline
System Model

(]

Coordinate with related
processes such as
Requirements Management,
Quality Mgmt and identify any
relevant existing information

Requirements may be stored
in Lifecycle Manager or other
requirements management
tools

uuuuuuuuuuuuuu

General

s | Rt ot L v e s s abes it [ty

Shor Tt ot Losd she ARG et v ot

This storyboard covers a MBSE approach to defining requirements
Lifecycle Manager provides structured text based requirements
management and can be used in conjunction with Modeler

© 2015 PTC
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Model Based System Engineering

» Capture System or Sub-system Requirements with CFT

£\ @EF.

System Determine the level and area of focus within
e Engineering the system and sub-systems
Engineer CFT
Capture System or \
Sub-system “
Requirements with \
CFT T éj - -~ 1 TOp down Cascade requirements
_____ ( B c / down from higher levels if
| * appropriate
—_——— e — —_ T — — — — — — \
(| OB mE N B widde out |
Confirm Requirements | I |
I 7 A o O e R
l N\ Y ___ /
3. ’
Update and Baseline
System Model Bottom up

]
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Model Based System Engineering

» Capture System or Sub-system Requirements with CFT

Collect drivers for the new system : : :
from the Requirements Management For more details on how to capture requirements in
System system Lifecycle Manager, please refer to Collaborative
Engineer Requirements Definition Best Practice Storyboard
BP Storyboard
o v e 77 <
Document — § i Ip ‘M_.'.
-
T Section Tee Category Trace Status Priority D
i B 1.1 - Systarn Racqui 1 — (1) Heading 4 none 1679 1678
Capture System or B | @i
i) 1.2.1 - Headi - .
Sub-system B | T8 v Medium Truck System Requirements
H H [ 1.2.1.2 - System Requirement )
ReqUIrementS Wlth : =) 1.2.2 - Heading 11 This document details the system requirements for the PTC Truck Mark 2 The truck shall be offered in variant [ System Requirement 3 downstream 1681 1678
C FT Ll [ 1.2.2.1 - System Requirement (| suitable for a range of established and emerging markets and offer varying levels of load and driver options.
] 9 1.2.3 - Heading 1.2 Market Heading & none 1683 1678
L @) 1.2.3.1 - System Requirement
§ E»EBB ﬂllznufad:;a = ~h2a Europe (i) Heading < none 1685 1678
; H 5 232 Sy oo 2 The vehicle shall be sold into the European market £ System Requirement 3 downsiream - s o
Analyzeand Refme w , be.s:m- St 212 The vahicla shall be availabls in lef and right-hand driver versions. ) System Requirement 3 downstream = High 1609 167
Requirements - L it T - e e s e s
] B 1.3.2.1.1 - System Requirement
] ) 1.3.2.1.2 - System Requirement 221 The vahicle shall be sold into the US market. [ system Requirement 4 downstream = High 1693 1678
|| = &31322‘:“;;'“ - 23 China (i) Heading & none 1695 1678
: @ 1 ;‘;l;;:’: et : 1231 The vehicle shall be sold into the Chinese market ) System Requirement 3 downstream - Medum 1697 1678
L B[;;l“‘ww i Functional (8 Heading \ 1699 1678
L [ 1.3.3.1.1 - System Requirement 2
D 1.3.3.1.2 - System Requirement 1.3.1 (1) Heading 4 none 1701 1678
| D 1‘3.3.1.3-s;am Requirement
|| @il 1.3.3.1.4 - Heading a8
X Ll fil) 1.3.3.1.5 - Heading Load
Update and Basellne @l a’iﬂ:_:‘:u::aw :1-3-1-1 The vehicle shall be capable of carrying “medium duty” loads (class 4 56). D) System Requirement 3 downstream - Critical 1703 1678
System Model : i) 1.5 - Heading 1312 The gross vehicle waight rating shall not exceed 7,500 kg (16 5001b). ) System Requirement 5 downstream = Critical 1705 1678
L () 1.6 - Heading — 1) Heading @ none 1707 1678
®
Euel
Synchronization of requirements between Lifecycle @ e
Manager and Modeler is often iterative and includes rent 3 downstreom  mm Gl 167
additions, deletions and modifications
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Model Based System Engineering

> Capture System orSub system Requirements with CFT

= |3 Test Sutte: System Te._.r Medum Truck (1775) *
‘Shaw tems contaning - | whery . g
T Pass requirements from Lifecycle Manager to
L [PTC ] Modeler and vice versa.
[ 2l 121 - Heading . .
H || o Medium Truck System Requirel Use the ‘Integration for Lifecycle Manager.’
& 50l 122~ Hesding ha This document detals the system requirements for the PTC Truck Mark 2 The
System ] D 1.2.2.1 - Sysem Requirement L 3ukable for 3 range of estabished and emerging markets and ofer varying levels of load and deive op
Engineer B s N Bt
: ::‘::141 m 121 Europe w—
D131 ement = ype Mappings.

H || [ G2 e e = e
[ 1321 - Hesdng paa USA Requirsments Profile
g g:;::;::w a2 The wehicie shail be soid into the US market B0 Roquemert Comment
0 ia T o = e (Bl RequynenDiagam
1=l 1.3.2.2.1 - System Requrement
= ia ‘3 ':::' s s 1231 The vehicle shall be 30id into the Chinese market T
- e 13

Capture System or B e r— B e

) 1.3.3.1.2 - System Requirement 131
Sub-system § 31 @
Requirements with B || Lo I o
CFT b= ul-"""“l AIJI.I The vehicle shall be capable of carying “medium duty” loads (class 45 6)
’:‘ @i 1.5 - Heading _:.1u The gross vehicle waght rating shall not exceed 7 500 kg (16 S001)
| :h:sm 132 Q
Fuel
Analyze and Refine : —

Requirements

_ Review imported S
0 Truck (ML) requirements that will drive (===

-] +Activities W nl

0 hssets system development X -

&0 +Blocks L7 atego In etror occured during the setting of the propedy vake

ﬁ el xception]
=] +Requirements aied to set propetty i
12 +The driver shall be legally allowed c;m::‘grflﬁawmﬂ % L
U d t d B | +The vehicle must comply with local fuel filling regulations S
p ate an aseline ! +The vehicle shall be capable of carrying loads ;EAJA&E =iy Pleaze wal.. r
System Model +The vehicle shall be capable of carrying "medium duty” loads (class 4,5,6), EASON: ”"‘““‘"“M"F Y Syxdrits.
+The gross vehicle weight rating shall not exceed 7,500 kg (16,5001b). 8/12/2014 15:53.22] Mapping Finding Modeler finks...
@ +Large Load “ [8ara0i4 1558 29 Macorod g
o4
[#-4%? +The vehicle shall be capable of displaying the temperature on the dashboard :ﬂ;ﬁﬂ: :;Eggg} :::g:g‘; B fanl y
[#-& +The vehicle shall be capable of refuelling . 18/12/2014 15:58.26] Mepping >
N i ; i 4 PTC" Integrity- JEES — Gooor el

w7 +Use Cases Q, DatadedLog

-] +Variation

5.8 +Driver Aboul |__Hel. < Back Next> Ext
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Model Based System Engineering

» Capture System or Sub-system Requirements with CFT

. System
System Engineering
Engineer CFT

Perform system
requirements gathering
sessions with the
cross-functional team

Include any other
relevant subject matter
experts, potentially

including customers and

Capture System or
Sub-system
Requirements with

Analyze and Refine
Requirements

|

Confirm Requirements

|

Update and Baseline
System Model

|®

end product users

Packages i
EI@ Truck System.

(-, +UML Profile

-4 +SysML Profile

5-5% +Atego Utilities Profile

[=REE] - Truck (SysML)

LfA] +[Packag Start Link

End Link...

| New 4 Package

Update All Profiles... Change Note
'/O‘therModeI... Comment

fernove from Package sidiE o

Capture data using

Sysl\éllhReq.uwements Scope To Package... Diagram | SysML y Block Definition Diagram
an equirements - MatriTable  » — N Obicct Disararm
. Links 3 il g
Diagrams e , Variabil _
Report » ¥ ariability  » Package Diagram
Tools » UNE L Atego 4 Requirement Diagram [~
Find 3 Variability P Sequence Diagram
Nnen m Atego 4 Text Diaoram

A requirement specifies a capability or condition that must (or should) be satisfied. A requirement may
specify a function that a system must perform or a performance condition a system must achieve
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Model Based System Engineering

» Capture System or Sub-system Requirements with CFT

Create new
o 4 : Requirements toolbar !: - - Requirement
b .59 ] = L 3] e @ b5

System Engineering -
Engineer CET i Packages > 4 x [Package] Truck (SysML) [2] X |
B@ Truck System.
"t +UML Profile req [Package] Truck (SysML) [2]J

-9 +SysML Profile

w38 +Atego Utilities Profile

200 +Truck (SysML)

H l«?! +Requirementl

+[Package] Truck (SysML) [1]
+[Package] Truck (SysML) [2]

Capture System or
Sub-system
Requirements with
CFT

areguirements
Requirement1

| (1 Packages FA = E S IR TR ——

i Properties of 'Requirementl’

Confirm Requirements Generl | Toe_| Optans | Changes | S| s | equrmment] )

@ l &) Requrement] Define Requirement
Update and Baseline Full name:  Truck (SysML)::Requirement 1 . p:(ipgrtlﬁs- [
System Model ext tab allows

Type: Requirsment / additional textual
information to be
Last changed on/by: 0170172015 18:01:19 PTCNET“Pollerton recorded
\ Vigibilty: @ Public ) Protected () Private () F‘ackageJ
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Model Based System Engineering

» Capture System or Sub-system Requirements with CFT

Capture what capabilities, functions or services the system or sub-system
must perform. Identify any actors that have an interaction with the system

Engineering - — = \ P

EET — -

req Requirements Diagram)
constraint1}

Constraints :
«requirements alequirements
can be added The vehicle shallbe capable of carrying loads The vehicle shallbe capable of carrying “medium duty”10ads (class 4,5,6).
- «requirements
arequirements The gross vehicleweight rating shall notexceed 7,500 kg (16,50010).

FYRTE TRy

System
Engineer

Capture Systemor | [Truck (sy=mD]
Sub-system L

Requirements with
D B arequir wx |
Th . areqmrernentx . The vehicle shaIIEro\ﬂ'de and en ent centre for the drive
evehicle shall provide a sleepingarea
«requrement= A . | .
The vehicleshallbe capableofreﬁ.lelling|< arefines The vehicle shall provi Decompose reqUIrementS
where needed

arequirements L Mew I

The vehicleshallbe capable of displaying the temperature on the dashboard

T deriveReqts

Confirm Requirements

l i v B x i Properties of ‘The driver shall be legally allowed to drive the truck’ AR |

Update and Baseline _ _ _ Generl | Tot..] Opioge | Chavase | e | o] o toment]
System MOdel Identlfylconflrm ConStralntS ‘Qf The driver shall be legally allowed to dive the truck
and performance measures. If
req u | red , Cascad e Ful name: Tk (SysML)::Requirements:: The driver shall be legally allowed to drive the truck
requirements and capture sub- Type:  Requirement
systems requ irements Last changed on/by: 02/06/2014 12:30:43  ATEGO\Happery

Visibility: @ Public ) Protected () Private (O Package

N[l F—r—
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Model Based System Engineering

» Analyze and Refine Requirements

Review, analyze and refine and
@Qa requirements with the CFT
ANBAT 7 | ey, pe—

Review requirements
definitions and associations

% to other requirements
.‘ \J System The driver shall be legally allows

e Engineering srequirements The vehicle shall dﬂegmtn:tm’ tcentre for the d

Engineer CFT The vehicle shall provide a sleeping area 12 venicle shall provide and entertainmentcentre for the drivs

___________ «requirements
arefines The vehicleshall provide ameans ofmaking hot and coldbeverages:

e — =

~ 3 % M Droperties of 'The vehicle shall provide a sleeping area’ )
Capture SyStem or | [sereni [T ] Options [ Changes [ iyl [ tems | Requiremert |
Sub-system e e———— @ﬁ |
Requirements with S
CFT e Analyze and review requirements for sub-systems
J ey Sleep within the context of the overall system
—— ) - satisfiedBy
. satisfies
Analyze and Refine : e _ _ _
. subRequirements The vehicle shall provide a means of making hot and cold beverages, The vehicle shall provide and entertainment centre forthi =
nts : synchronization Status ~ Undefined
tracesFrom
—— - —————-— - - tracesTo
:mdw The vehicle shall provide 3 sleeping area for the driver within the cab. The sleeping are shall comprise a bed, bedding and aca| Validate COfreCtneSS and
(S ..~ . : eliminate overlap
onfirm Requirements
@ l Perform analysis to confirm model is l\ _" “
Update and Baseline complete and correct (Refer to Automated
System Model System Design Review Best Practice)

]

Refer to the System Engineering Process Governance and
Efficient Design Review practices for additional information
on system engineering reviews
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Model Based System Engineering

» Confirm Requirements

Confirm and approve all
requirements with the CFT

System
SySte m Eng | nee ri ng | Packages > I X Requirements Diagram 2%~ Requirements Diagram X |
i [?] +Cab P Tem -
Englneer CFT +CapWTampp req Requirements Diagram

+Requirements Dia
- +Requirements Diagram 2
- §b +Use Case Diagram ( -
91 +Use Case Diagram 2 | emquremens p_ .
& +Variant Diagram The vehicle shall be capable of carrying loads
£ +Variant Diagram 2

— o o]
Truck (SysML)
1 +Requirements ‘ arequirsments
<z

afequirements
capable of carrying “medium duty” [oa

Cath I'e System OI' * + The driver shall belegally allowed to drive the t ‘Tne driver shall be«\:gq;:;e;:zrv::d to drive metruckl e =
) +The vehicle must comply with local fuel filling 1
Sub'sy tem +The vehicle shall be capable of carrying loads 5 -
R . t th +The vehicle shall be capable of carrying “m¢ S requirements _  erequirements
eq Ulremen S Wl +The gross vehicle weight rating shall not ex |The vehicleshall provide a sleepingarea The vehicle shall provide and entertainment centre for the df
CFT ' +Large Load
+The vehicle shall be capable of displaying the t¢
& +New «requirements e 4 arequirements
' +The vehicle shall be capable of refuelling The vehicle shall be capable of refuelling arefines Thevehicleshall provide ameans ofmaking hot and coldb,

+The vehicle shall provide a sleeping area
+The vehicle shall provide 2 means of makin

Analyze and Refme ) +The vehicle shall provide and entertsinmeni) srequirements L
Requ"'eme ts o Y— The vehicle shall be capable of displaying the temperature on the dashDoard e mm-—-———————

aderiveReqts
1 +Variation
-6 +Cab Physical Decision Set
<, +Cab Web Decision Set -
f (1 Packages =A@ & J-‘QD TR ——r—
i Items and Diagrams which use The vehicle shall be capable of carrying loads. + & X [ Properties of 'The vehicle shall be capable of carrying loads' 1 ? ¥
Name Type |Genaml |Tad | Options | Changes | Style | ttems ‘ Requirement
<% Truck (SysML)::Diagrams.Requirements Diagram equirementDiagram
[ Truck (SysML)::Diag Req Diag Requi Diag
$oTruck (SysML)::Diagrams.Use Case Diagram Use Case Diagram
2] Truc sML):Diagrams.Requirements Diagram equirementDiagram ag Definition Name ag Value
[ Truck (SysML)::Diag Req Diagram 2 Reg Diag Tag Defi N Tag Val
U d t d B |- %DTruck (SysML):Diagrams.Use Case Diagram 2 Use Case Diagram derived [
p a e an ase Ine O Truck (SysML)::Use Cases.Load Use Case derivedFrom
S Stem Model 2 Truck (SysML)::Use Cases.Unload Use Case id#
y isDeletedinDoors FALSE
L J isBdemallyManaged  FALSE

isinDoors FALSE

[l TR TE]

N

Update requirements
model if needed
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Model Based Product Line Engineering Best Practice

Pass System Level Requirements, Model
Elements and Trace Links to Lifecycle

» Confirm Requirements

: Modeler
: Packages - 1 "
. +UML Profile
-7 +SysML Profile
5% +Atego Utilities Profile
=0 +Truck (SysML)
Type Mappings
-] +Activities L : = :
System (1] +Assets aB'BgD' Modeler Item Type Mapped Categories -
3 (1 +Blocks Requirements Profile |
Englneer -1 +Diagrams | & Requrement Comment
ﬂﬁ ) L'Eﬁul}nmbmqam Comment 1
-] +Requirements SysML Profile -
M Block Comment
| BlockDelrstionDiagram ~ Comment
+The vehicle shall be capable of carryil3y loads =] +D: Comment .
' +The vehicle shall be capable of carrying "medium dur UML - "memmnh = e
' +The gross vehicle weight rating shall not exceed 7,500 © | @ Activiy
) +Large Load | #ActiviyDia]  Raquirement Mapping Options
) +The vehicle shall be capable of displaying the temperature ; Actor V-4 a‘,ogo. Object Synchronuation Direction
Captu re System Or +The vehicle shall be capable of refuelling b E::" Sudo <> Integity
e
+The vehicle shall provide a sleeping area Ftegrty > Studio
= . Keep Unsynchronized tems
Sub-sy tem (] +Use Cases L} © Swudio > Integrty

Requirements with
CFT

Analyze and Refine
Requirements

Update and Baseline
System Model

-] +Variation

=+ +Cab Web Decision Set

-+4 +Cab Physical Decision Set

| B |

I

B 1.3.1.1 - System Requirement
D 1.3.1.2 - System Requirement
2 13.2 - Heading
Sl 1.32.1 - Hesdng
D) 1.3.2.1.1 - System Requrement
D) 1.3.2.1.2 - System Raqurement
2 1322 - Headng
Q13221 - Sysem Requrement
013222 System Raqurement
Sl 133 - Heading
S 1.33.1 - Headng
D 1:3.3.0.1 - System Requrement
@ 1.3.3.1.2 - System Requrement
@1.33.13 - System Requrement
@it 1.3.3.1.4 - Headng
@il 13315 - Headng.
B0 1.34 - Heading
i 1.4 - Hoading
@il 1.5 - Heading
@i 1.6 - Heading
B e

EEEEEEEL

[ i

==

| S [

T

haa

1312
132

~haaa

r

B

PTC Integrity-

2 PTC Integnty Modeler Lifecycle Manager Synchronizer

Medium Truck System Requirement

This document details the system requirements for the PTC Truck Mark 2 The truck shall be
‘suable for 3 range of estabiished and emerging markets and ofer varying levels of load and dn

Market

woraation Log

Europe

The wehicle shall be sold into the Eutopean market
The wehicle shail be avadable in lef and nghe-hand drier versions.

Usa

The wehicie shail be soid inte the US market
China

The wehicle shall be sold int the Chiness market

Functional

Load @

The wehicle shall be capable of carrying ‘medium duty” loads (class 45 5)
The gross vehicle weight rating shail not exceed 7 500 kg (16 5001b)

L ]8/12/2014 15:53:22] Mapongd

SN

xception)
jaded to set property

{n 2rror occurned during the setting of the propery value:

sended Erot Info)
paration on Clazs Fequremar
PERATION: Set Pioperty
PE: NAME Aieikyps 4
EASON: Name is not unqua « F s
L
8/12/2014 15.53.22) Mapping Finding Modeler inks. .

8/12/2014 1553:22] Maporog
8/12/2014 1553 26] Maponog
8/12/2014 1553.26] Maponod &

Found0

18/12/2014 15.53.26] Mapping

Fuel Q

PetrolGasoline
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Model Based System Engineering

» Update System Model

Update system domain model if needed (refine

-

\ %_ ) system structures in system domain model)
System
Engineer N /
[ bad BOD CTrUckDOMaI) \/

Capture System or
Sub-system =
Requirements with 1£ [ 1 1 1 .
= 0 R |

Analyze and Refine o e, Enainer
Requirements
IE n
~ B X i Properties of 'Service Engineer'
General |Tex1 |[}|angas|5tyle |lterns |
Update and Base“ne Visibility Changed By Changed On % [y —

Fullname:  Truck (SysML)::Use Cases Service Engineer

System Model

Type: Actor
Last changed on/by: 07/01/2015 13:30:38 PTCNET Pollertton

Visibility: @ Public ) Protected  (7) Private (0 Package
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Model Based System Engineering

» Update System Model

Creating a new version is a common

way to baseline the model. Launch the
Model Explorer (or select File > Open
from with Modeler)

System
Engineer

E;_ Examples - Artisan Model Explorer

Lookin: “\Enabler\POLLERTOMILL \Exarmples\Truck System

Select the model and click New to
create a new version

| (=) |

E|*" gabler * || Name Version
=L § POLLERTOMNILL - :
Captu re SyStem or El":i Examples % E:;n::::;; c Creates a new version or branch g
Sl.!b-system . @ Active Deferred Ball Game Example @ Heart Monitor Java 0
Requirements with -l BallCop , & Hsuv 0
CFT @ O.ﬁ Alnother Block (Tetris) Example | @ Search and Rescue o
@ Distributed Ball Game MDA Example |=
.[§] Filling Station 4] Speed Controller 0
@ Heart Monitar € @ Template - Component-based Products 0
Analyze and Refme @ Heart Monitor Java @ Template - IncremenFaI Process 0
ReqUirementS @ H5UY Fi| Temf}lat-e - Small Project 0
@ Search and Rescue L @ Traffic Lights 0
@ Speed Controller : iCli ey ST 0
@ Template - Component-based Produ 4
@ Template - Incremental Process 4 VB Another Block (Tetris) Example 0
@ Template - Small Project @ Waste System 0
--[£] Traffic Lights -
4| 1 | 4 [ |

Last Changed By

PTCNETWPollerto
PTCNET\Pollerto

UK-CHE-DTP-02:

PTCNETWPollerto
UK-CHE-DTP-022
UK-CHE-DTP-02:
UK-CHE-DTP-02:
UK-CHE-DTP-02:
UK-CHE-DTP-02:
UK-CHE-DTP-02:
UK-CHE-DTP-02:
PTCMET\Pollerto,
UK-CHE-DTP-02:
UK-CHE-DTP-02:

& |2 F-E @

e

m

Truck System

Update and Baseline
System Model

Version: 4

Last Changed By: PTCNET \Pollerton Last Operation:

© 2015 PTC

Last Changed On: 20/01/2015 10:50:12

Created By: PTCNET \Pollerton
Created On: 12/12/2014 15:34:34

E .
1

Close




Model Based System Engineering

» Update System Model

System
Engineer

e

Capture System or
Sub-system
Requirements with
CFT

Analyze and Refine
Requirements

Confirm Reqwrements

Update and Baseline
! System Model

I —— e —

If a copy of the file needs to be stored in
another location, Export can be used.

File | Edit Tools Window Help

Choose File >
Model > Export

[ Mew Model... Ctrl+M | Environment
| Open Model... Ctrl+ O
Close Model
| Model 4 Clone L
View Log 3 Export...
Mew Diagram 3 Protect

Mlass: Warcinm

Select a location
and enter a name for
exported model (.zip

format)

e » Computer » System () »

Organize ~ New foider

[, Recent 2 Name ype
O b Gz @ SRecycleBin File folder
B Somches boot File folder
: ::::mu @ Documents and Settings File foldes
['; Tenplates found 000 File folder
B Tadeg L dntel File Folder
amC M50Cache File foider
L Perflogs File folder
“ Sytem (O} ). Program Files File folder
L“‘ Deta ) 4. Program Files (x86) File folder
. 9 YD Deve (9 ProgramData File folder
;?:ZT»»« S File folder
4 Recycle Bin Rasonesy Fhefolm
Tir System Velume Informaticn File folder
= L temo 9/12/2014 130 File foldes
I File name:  Truck System vi_20_Jen_20150p I
Save as type: | Zip Files (")
o VideFodes [sme ]

© 2015 PTC
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Design Use Cases



Model Based System Engineering Best Practice

Procedure

» Design Use Cases

System
Engineer

* Objectives
— Capture and document use cases and relationships

Engineering
CE

* Role
® — System Engineer
Plan Syst .
— Cross-functional Team

I
Define & Analyze . Ou’[p uts

System Context
— Use Case Model

Design Functional View

Design Architecture

Allocate Architecture
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Model Based System Engineering

» Design Use Cases

System

] Engineering
Engineer

CET

Plan Systems
Engineering Initiative

Define & Analyze
System Context

Design Functional View

Design Architecture

Allocate Architecture

Define/Confirm System
Actors with CFT

|

Define Use Cases and

Relationships

4

Associate Use Cases
to Requirements

© 2015 PTC
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Model Based System Engineering

» Design System Actors with CFT

‘ g A‘ ‘3 Work with the CFT to

S;/stem System identify and Use case diagrams focus on system
e Enggﬁnng document use cases behavior. They describe the usage of a
system (subject) by its actors

(environment) to achieve a goal, which
is realized by the subject providing a
set of services to selected actors

| i Packages v X
l 9@ Truck System

- +ACS Profile

-4 +Asset Profile

-8 +IDL Profile

+UML Profile

#L +SysML Profile

w55 +Atego Utilities Profile
g0 ,
@00 +Acti Start Link
-0 +Asse End Link...
- - +Blocl Synchronize IDL Element Mames
mD +Diag

Define Use Cases and

Relationships

|

Associate Use Cases
to Requirements

Right click on a {0 +Reqy
. = N
suitable package |2 E:ZJ e Package
. L+ p les. - N
and click New > & +Cab Update All Profiles ‘ ange tote
i Diff With Other Model... ommen
> >
Dlagram SySML } Constraint

OpenIDL File

Remove from Package

Use Case Diagram |"'_""'+§oftwE

i Scope To Package... Diagram D SysML Block Definition Diagram
& +IDL_Exan - DnC Profile 2 UML 3 Object Diagram
@] +IDL Ean| | Links i _ L=sbl
-[_] +Budget Report 3 IDCRehle b Variability — » Package Diagram
+Graphicg Tools » Matri/Table  » Atego L4 Requirement Diagram
+?UC:_||\_"1 Find o SysML 4 Sequence Diagram
: +Truck Tg UML N
Open »
(1 Packages - Variability v
i R I Atenn S e
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Model Based System Engineering

» Design System Actors with CFT

Confirm the name of the new diagram
and specify any other options

N/

System Engineering

Engineer CET

! Properties of 'UseCase Diagram'

General | Text I[:hanges | Style I ltems |
%)D |JzeCase Diagram "y
Fullname:  Truck (SysML).UseCase Diagram Priaiainl] N
® - :
ine System Actor Page reference: Driver
: Wlth CFT Type: |Jze Caze Diagram
b o o o o o e e e Last changed on/by:  06/01/2015 13:01:05 PTCMET \Pollerton
@ . Visibilty: @) Public  (7) Protected  (0) Private  (7) Package
Define Use Cases and
Relationships
l Fuel Station
@ . Operative
Associate Use Cases
to Requirements

7,

Add Actors to represent any entity
that will interact with the system

e

Define properties for Actor

© 2015 PTC

mnpertis of 'Driver'

General |Tad I[}hanges I Style | ltems |

% Driver

A Fullmame:  Toyck (SysML) Driver

Type: Actor
Last changed on/by: 05/01/2015 13:12:556 PTCMET“Fallettan

Vigibilty: @) Public ) Protected  (7) Private  (©) Package

.

J
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Model Based System Engineering

» Define Use Cases and Relationships

- 1ent - i
@@3 ImEE L o —S3 ¢ 4@ - AL

.
Engineering =

Engineer

services the system must
deliver

Define System Actors
with CFT

Operate Truck

CE Add use cases for the I>
significant functions or

aincludexs

Interaction
type
[ i i Fuel Stati
Associate Use Cases relationship e Staton

to Requirements

J e

Include type
relationship

Use cases can
be created at
any level within
the system
hierarchy

Properties of 'Operate Truck'

General |Text |'I"u'nir1g| Mote | Changes | Style | ltems |

o Operate Truck

Full mame:  Truck (SysML).Operate Truck

Type: Use Case

Visibility: @) Public () Protected

Last changed on/by: 05/01/2015 13:14:06 PTCNET Pollerton

(7) Private () Package J
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Model Based System Engineering

» Define Use Cases and Relationships

System

1 Engineering
Engineer

CEI

Define System Actors
with CFT

Y S—

Define Use Cases and :

ssociate Use Cases
to Requirements

A2 +Assets
{21 +Blocks

g e

] +Dj
0 +R
20

Start Link
End Link...

Synchronize IDL Element Names

Use case descriptions
can also be created to
provide further
information and also
capture multiple
scenarios

Load UC Description* X

Open DL File

New Package

Update All Profiles... Change Note

Diff With Other Model... Comment

Remove from Package CEpEiEmE

Scope To Package... Diagram ’T‘ Block Definition Diagram
T DnC Profile UML N Object Diagram
Report LG = 4 Vanability Package Diagram
Tools Matrix/Table  » Atege Requirement Diagram
Find SysML L Sequence Diagram
Open UML ’ Text Diagram

Merge Variability > | Use Case Eagram

Create Text diagrams to
capture textual
descriptions of use cases

© 2015 PTC

Use Case ID
LT001

Use Case Name
Load Truck

Actors
Driver

Description
The driver confirms load suitability and loads securely onto truck.

Preconditions
1. Load available and weight correct
2. Loading mechanism available

Postconditions

1. Truck loaded

2. Collection recorded in electronic tracking system
3=.Receipl or invoice paperwork provided

Normal Flow

1. Driver inspects load to ensure weight is correct and packaged ready for loading
2. Driver utilises loading mechanism to load onto truck

3. Driver ensures load is secured as appropriate

4. Driver records collection in electronic tracking system

5. Driver provides receipt or invoice paperwork

Alternative Flows

1. Driver inspects load to ensure weight is correct and packaged ready for loading
2. Driver manually loads onto truck

3. Driver ensures load is secured as appropriate

4. Driver records collection in electronic tracking system

5. Driver provides receipt or invoice paperwork

Exceptions
Load too heawy or too large for truck capacity




Model Based System Engineering

» Associate Use Cases to Requirements

Use cases provide additional details on the behavior needed to implement a
requirement. Therefore it can be useful to link a requirement to it’s related use case

System
Engineering
CET

Define System Actors
with CFT

Define Use Cases and

Relationships

R
Associae se Cases
: to Requirements :

Engineer

]

EPackas -~ I x

Diagram X I

g +Variant Diagram o
& +Variant Diagram 2
@ +Variant Holder
=] +Requirements
1% +The driver shall be legally allowed to drive the truck
shlssualesel ’ iasbasnadebonniniokis
-4 +The vehicle shall be capable of carrying loads

: ,Q_? +The gross vehicle weig
" +Large Load
'/ +The vehicle shall be ca

(- +The vehicle shall be
L0 02 e Thevehicle chall ny

ting shall not exceed

@ - e
1 =" gincludes
Jh Operate Truck

Drag and drop the existing
requirement into the use case

Fuel Station

diagram window

s Operative
[-~¢, +Cab Web Decision Set

< o 3
“:I Packages

.

-

playing the temp’ Drriver \\ wincldes
elling \\ .

.

lﬁ'al@ll mEm Lo gol— 524 o-fn]ag

L

seCase Diagram X | Requirements Diagram X | Refine N

wrequirements
The vehicle shall be capable of carrying loads:

e

Trace
Copy
Derive Reqt
Satisfy
Verify

-
4

PR

«requirements
The Jehicle shall be capable of carrying loads

@) 7
I - wincludes
JL ‘Operate Truck

Driver ., vinclides
\\

Y
Unload

Fuel Station
Operative

.

Add a Refine
relationship
between use case
and requirement
(Use Refine as we
are still modelling
the problem
domain)

© 2015 PTC
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Model Based System Engineering

» Associate Use Cases to Requirements

System
System Engineering
Engineer CET

—

Define System Actors
with CFT

Define Use Cases and
Relationships

______ —

I

Associate Use Cases
]

]

to Requirements

L

Select Frame Box and
drag the box around
the use cases in the

As with Block Definition Diagrams, it is possible to put a
system boundary onto a use case diagram

T L4 dbd dib

3 L[] & of

ln

.

system

~
B

Driver L

}

Fuel Station
Operative

™\

~ Operate Truck )
b L

o /
-
=" «includes

., A
. «includes
~.

P

«refine

«requirements
The vehicle shall be capable of carry

© 2015 PTC
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Model Based System Engineering

» Associate Use Cases to Requirements

System
System Engineering
Engineer CET

Define System Actors

with CFT
@

efine Use Cases and

Relationships

e S

Associate Use Cases H
to Requirements

iie?) +The driver shall be Iegally allowed to drive the truck

..:a T Lo rl; L Lo g o 1egu|atlon' “ | Tludt{SysMLjI

G U = 4] [ (< s ) 2 ™ Link b .
@) +The gross vehicle weight rating End Link... 2 TO naVIgate from a
) +Large Load requirement to related use
. . Generate Budget Report R
-2 +The vehicle shall be capable of disp| cases or use case dlagrams,
y . Help q q .

[l ﬂc_? +The vehicle shall be capable of refu I'Ight click on the reqwrement

-&? +The vehicle shall provide a sleeping| MNew 4

. : and select Report > Usage
ases Open IDL File
[ Ac.torl Set R
M- % +Driver
- % +Fuel Station Operative Open ’
- +5ervice Engineer Roll Up Contextual Features
[ +cab: Load Bay
[ +Instancel : Chassis Browse Class..
@& +Instance? : Long Chassis Links 3
- +Drive Report 4 Consistency
- +Load = N
ools -

-4 +Operate Truck _ Details
@ +Refuling Lixd r Usage P
-4 +5leep Merge Aecociated Diagr){ls
(- +Unload Applied Stereotypes » . one

! Ttems and Diagrams which use The vehicle shall be capable of carrying loads.

1
J
/

Name

Related use cases

Type

%T—'Truck (SysML) . MseCase Diagram
S Truck (SysML)::Diagrams.Use Case Diagram
%PTruck (SysML):Diagrams.Use Case Diagram 2
2 Truck (SysML).Load

3 Truck (SysML):Use Cases.Load
C) Truck (SysML)::Use Cases.Unload

and use case

diagrams are
displayed in the
Results window.
Related diagrams
can be opened by
double clicking

.Truck (SysML): Dlagrams Requirements Diagram 2
.Truck (SysML)::Blecks:Engine[Block] Engine [1]

Use Case Diagram
Use Case Diagram

Use Case Diagram

Use Case This view shows
Usze Case i

e usage, it does not
ce Lase

show actual links
between model
item. Refer to the

requirementliiagram

RequirementDiagram

InternalBleckDiagram

(1] B Resutts [B] [&]E

next slide for
more information
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Model Based System Engineering

» Associate Use Cases to Requirements

System - Activities
Engineerin -] Assets ' . .
Engineer g(:FT 3 -0 Blocks To display all relationships between model
-] Diagrams items use the Relationship browser

BD Requirernents
[-Z1 Dependents
[:l Depends On

[:l Formal Parameters

[:l Applied Comments

[:l Applied Constraints

'&2) The driver shall be legally allowed to drive the truck
' The vehicle must comply with local fuel filling regulations Locate the requirement and

| A The vehicle shall be capable of carrvina loads1 _— expand the Dependents folder

Define System Actors
with CFT
l -1 Dependents
Define Use Cases and Eg s
Relationships off.r, Refine

D Actual Parameters

w-----L------l -3 Applied Comments

y Associate Use Cases -0 Applied Constraints | ~~— | Relationships are
: to Requ|rements : ,Q_:P The vehicle shall be capable of carrying loads displayed, in this case the
e ———— D_'—”ad Refine link between
=0, ine .
- Actual Parameters requirement and the Load
D Applied Comments SEEluEE

-0 Applied Constraints

,&‘? The vehicle shall be capable of carrying loads
- Unload

(-2 Depends On

-1 Classifier Behaviors

-7 Subclasses
< i |

[ @[] i Relationships (&%~ [%5]a]-1].5]2]<
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Model Based System Engineering Best Practice

Procedure

» Design Functional View

System
Engineer

* Objectives
— Define functional interactions and preliminary functional architecture

Engineering
CE

* Role
® — System Engineer
Plan Syst .
Engineering Inifiaive — Cross-functional Team
|
Define & Analyze °
Sylsr:em antgf(t OUtpUtS .
3.0 | — Interaction Model
Analyze Requirements — Functional Architecture Model

Design Use Cases

i Design Functional View |

s S

Design Architecture

Allocate Architecture
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Model Based System Engineering

» Design Functional View

System

] Engineering
Engineer

CET

Plan Systems
Engineering Initiative

Define & Analyze
System Context

@ I

Analyze Requirements

Design Use Cases

@ _____ i [ ——

I
i Design Functional View |

s S

Design Architecture

Allocate Architecture

S

Create Sequence
Diagram with CFT

@ Define Lifelines and
Messages

© 2015 PTC
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Model Based System Engineering

» Create Sequence Diagram with CFT

For use cases that need to be documented in more detail,
specifically describing the interactions between actors and the

cludes
.\\ system, a sequence diagram can be used
_ Engineering s
Engineer CET ——
1cludes = Operate Truck
e Show/Hide Compartments...
.-“’p -
-~ Start Link . .
cuees 2 S L Right click on the use case and
n MK o
-~ / Add select New >Sequence Diagram
includes r
V4 Links » ~
______.i / " o
Inciu ools ¥
Create Sequence ) ) Operate Truck XrUseCase Diagram X]
Diagram with CFT Populate ' 1
Autosize Operate Truck
| New * Activity M I
Define Lifelines and Open v Comment !
Messages Remove from Package Constraint :
I
l roperties of 'Operate Truck' Scope To Package.. State Machine ] |
- -.’ I
ienersl [Text | Timing Note | Chal | Report C |
Find » :
D Operate Truck Ierne |
I
I

~

@ Ny )
Properties of 'Operate Truck'
-

The Sequence diagram describes the
General |Text I[:hangesISter Iltems |

flow of control between actors and Enter name m po——

o perate Tru
systems (blocks) or between parts of a for diagram =
system. This diagram represents the and select Flame: - Thack (SyeML):Use Cases Oparte Tk Operte Tk
sending and receiving of messages options Pagereferencs: 3D
between the interacting entities called Type: Sequence Diagram
lifelines, where time is represented Last changed on/by: 06/01/2015 18:52:25 PTCNET\Poletton
a|0ng the vertical axis Visbilty: @) Public ) Protected (7 Private  (©) Package
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Model Based System Engineering

» Create Sequence Diagram with CFT

System
Engineer

Engineering
CFT

Create Sequence

Diagram with CFT

Define Lifelines and
Messages

b

Click on Sequence and then
click in diagram window
below the text Description.
Add a sequence to the
diagram and enter a name

x|
A new actor :
b +Wariant Dhagram
can be added i +Variant Di 2
ST e ’ Loy +Variant Holder

correct actor
already exists

H-1 +Requirerents
-]D +Use Cases
G- 2 +Actorl

in the model,
drag and drop \ ks + Fuel Statior"pergtive
into the & § +Service Engineer
diagram as 3 +cab: Load Bay

shown below - :-::1 +Instancel : Chassis _
[]—- +Instance? : Long Chassis
#-£23 +Drive
[H-{r +Load

~.-———'

m

Operate Truck

Description

A F——|

RN T —

! Properties of "Truck (SysML):Use Cases.Operate Truck.Operate Trucl

General | Full Text | ftems.

%@ Driver loads the bay
3

Type: seq

Last changed on:  06/01/2015 15:02:34

Operate Truck

Description

Driver loads t}eﬁa’y

’/

-

Truck (SysML):-Use Cases Driver

© 2015 PTC
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Model Based System Engineering

» Define Lifelines and Messages

System
Engineer

Create Sequence
Diagram with CFT

Define Lifelines and
Messages

Add BlockProperty items to the diagram
to represent system components

Drag and drop existing BlockProperty
items (created earlier and displayed on
Internal Block Diagrams)

xﬁomain} x ;

[ T —— P— ¥
Packages > 3 x IBD (Truck) %/ Operate Truck X [ Use Case Diagram X | BDD
; - +Road - o
M| +Sleepr Cab Operate Truck
@ +Spring Clamp [Truck (SysML):Use Cases.DriverI ﬁ
M +Temp Sensor T M | .
: B +Temperature System Driver loads the bay : " 1
-l +Truck | Y '
; a -Day Cab: Day Cab I ‘,’ 1 :
-Sleeper Cab : Sleepr Cab : ,’ : 1
-Chassis : Chassis I ,/ | !
-Drive Axle: Drive Axle ! P4 l !
1 I
L L ﬁ' . .
|
-Load Bay : Load Bay F~ ’/4 | ! Lifeline
— = = S - ] 1 !
TeCaree uarag N~ —‘g .
-: Day Cab - : : 1
-Day Cab : Day Cab = !
-Chassis: Chassis
b | % *" _i* i} | Dperate Truck
Jescription [Truck (SysML)::Use Cases.DriverI ﬁ
T

Select Operation
to add a
message

Jriver loads the bay

Drag line from
the actor to the
BlockProperty

] Select Object

(2] = |

Select an object from the list to use. You can search for an itern in the list by typing the first few characters of its name in the adit
contral abowve the list. Pressing the New button will create an itern using the name in the edit contral.

Can re-use existi

new operation

operation or create a

ng

Ba Load Bay
[ All Operations

Signature  Parent

% Load () Truck (SysML):Blocks:Load Bay
% Unload () Truck (SysML)::Blocks:Load Bay

© 2015 PTC
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Model Based System Engineering

> Deflne Llfellnes and Messages The operation will be added to diagram

Operate Truck

[Truck [SysML)::Use Cases.Driverl
I

Diriver loads the bay

¥ B

Load ‘ hill

System
Engineer

Operations describe
L F—T— functions that should be
provided by the system

- - - - -0

> 3 x i Properties of ‘Load’

General |Text | Options: | Sig'turel Retum | Changes | Style | ltems I Body | 'I"u‘ning|

Q Load |

S

Create Sequence

; : Full name:  Truck (SysML):Blocks::Load Bay.Load
Diagram with CFT
/\ C ouemn Continue to add
ype: peration . fi
@ D f' L'f |. d Enter a name and F201510:50:21  PTCNET Pollerton Opt?]reatslgglsjetr?cdeeolfne
erine Lirelines an - p_— . . .
Messages define properties ) Protected () Private  (7) Package interactions
— as needed
1 Operate Truck III V

[ CoadBay | TDmyCeb] [ SiesperCab |
1
1

Driver loads the load bay

Load 1

Drive bI|
U

Driver drives the truck from the

1 ! ' :
; Py, | :
cap | ! : !
. . If over night trip ! 1 : 1 1
Drive the Vehicle ) ) ! . .
— Driver sleeps in sleeper cab f | | | S\eep H
_ Driver drives next day : T 1 Drive I "
end alt : : : N :
if engine not I'I.IFII"IiI"Ig Driver unloads the load bay h Unload P.- 1 : :
. 1
startup ! i i . i |
end if
loop
lerat
acceleraie ‘; -
brake Logical constructs can be
end loop defined within the sequence

|
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Model Based System Engineering

» Define Lifelines and Messages

Operations become part of the target block
and are displayed on diagrams (if
compartment is visible)

, S e
\ &Ml +Ignition System
+Load
System a8
Engineer M| +Load Bay
-~ - : Bay Fixing
&-% +Load

G--% +Unload
Gl +Long Chassis
- 1l| +Piston

[].... +Powertrain
i@l +Rear Spring
&l +Road

-l +5leepr Cab
-El* -1 Cab Fixing
- - ECU
M8 -+ Mechanical Sub-system 1

@ - Bay Fixing

Create Sequence
Diagram with CFT

Connector

52

_______l__---- o

Define Lifelines and
Messages

Artisan Studio
S

I Compartments to display

_ OpenIDLFile
| Show/Hide Compartments... N |

Inherited Operation
Mew Part Type

Start Link )
End Link... Operation l
Add » A
Ctther Role =]
Help Owned Comment
- Bay Fixing finks >

Right click on the block and select
Show/Hide Compartments...
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Model Based System Engineering Best Practice

Procedure
» Design Architecture

System
Engineer

* Objectives
— Design, analyze and review system architecture

Engineering
CE

* Role
® — System Engineer
Plan Syst .
— Cross-functional Team

I
Define & Analyze . Ou’[p uts

System Context

@ | — System Architecture Model

Analyze Requirements

Design Use Cases

Design Functional View

Allocate Architecture

© 2015 PTC 7



Model Based System Engineering

» Design Architecture

System

] Engineering
Engineer

CET

Plan Systems
Engineering Initiative

Define & Analyze
System Context

Analyze Requirements

Design Use Cases

Design Functional View

Allocate Architecture

Define System Blocks

}

Define Internal Blocks,
Ports and ltem Flows

|

Define Constraint Blocks
and Parametric Diagrams

Review System
Architecture Design

© 2015 PTC
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Model Based System Engineering

» Update System Model

-

£\ @EF.

System
System Engineering
Engineer CFT

{ Define System Blocks  fi]
1 1

______1______—

Define Internal Blocks,
Ports and ltem Flows

Define Constraint Blocks
and Parametric Diagrams

@ Review System
Architecture Design

DE Examples - Open Model

Before commencing the detailed design of the system, create
another baseline of the model. System requirements should be
frozen and only be modified via a managed change process

Look in: \\Enabler\POLLERTOMNLL1\Examples\Truck System

=1+ Enabler
BD POLLERTONILL
Eg Examples

Creating a new version of
the model

3 Heart Menitor
3 Heart Menitor Java
& Hsuv

3 Search and Rescue
3 Speed Controller
3 Template - Component-based Produ

3 Template - Incremental Process
3 Template - Small Project

3 Traffic Lights

|4 Traffic Lights - SySim

3 Truck System

3 VB Another Block (Tetris) Example
-[£] Waste System

[;j Models

r—

MName
@ Active Deferred Ball Game Exa
& Balicpp Creates a new version or branch

|£ C= Another Block (Tetris) Examplle
@ Distributed Ball Game MDA Example
|4 Filling Station

@ Heart Monitor C

@ Heart Monitor Java

& Hsuv

@ Search and Rescue

@ Speed Controller

@ Template - Component-based Products
@ Template - Incremental Process

@ Template - Small Project

@ Traffic Lights

oo

@ Waste System

ris) Example

counwooococoocococoo0ooo

< 1]

oo Access permissions
w-chf  can be defined for
UK-CHI

o the model

PTCNE

UK-CHE-DTP-022\.. 08/09/2014 15
UK-CHE-DTP-022\.. 08/09/2014 15

Truck System

™ Version: 5
Last Changed By: PTCNET \Pollerton
Last Changed On: 20/01/2015 10:50:12
Last Operation:

Created By: PTCMNET\Pollerton

Created On: 20/01/2015 12:52:22
Attributes: RWO
Comment:

© 2014 PTC




Model Based System Engineering

» Define System Blocks

Cascade requirements down from higher
e @Q(’ . . ) . levels and define Block Definition Diagrams
'%'—7 R ARV After creating the various models in previous and Internal Block Diagrams to describe the
N steps, system requirements will have been various sub-systems
Engineering refined and elaborated and there will be a
CET greater understanding of the needed

system/sub-system structure as well as
system functions

System
Engineer

1
Define Internal Blocks, = il _______ — 1
Ports and Item Flows ( B C \ A
I
I

v

Define Constraint Blocks b—t———pF——a———1l
and Parametric Diagrams (! o ][ E [ F][o] \‘\
| N
: N -/
Review System | |
Architecture Design |
[ H [ J /I
\_____ _

Sub-systems that can stand-alone may be
better defined as a separate system model
and then linked using Asset Library
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Model Based System Engineering

» Define System Blocks
Truck sub-system block

) @@3 definition diagram
\'-} g VAN A. ﬁ

- System bdd Track 800) Dashboard sub-system
System Engineering
Engineer CFT

Define Internal Blocks,
Ports and ltem Flows

v

Define Constraint Blocks
and Parametric Diagrams

Review System
Architecture Design

Ignition
sub-
system

Engine sub- !

system -

ECU software
component

o

© 2015 PTC 81
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level sub-systems




Model Based System Engineering

» Define System Blocks

System
System Engineering
Engineer CFT

] Define System Blocks |
1

_____1______—

Deﬂne Internal Blocks,
Ports and Item Flows

Defl

ne Constramt Blocks
and Parametnc Diagrams

Review System
Architecture Design

[#--g* -: Engine Mount

a - 1 Drive shaft

a -: Chassis

@l +Engine Mount

=M +Environment
a -:Road
a -1 Air

@l +Front Spring

. +Fuel

. +Garage

. +Gears

M +Load

. +Load Axle

—. +Load Bay

--ﬂ' - : Bay Fixing

-% +Load

- % +Unload

-% +Load

. +Powertrain

: B -: Transmission
a - : Drive shaft
E - :Engine

a - : Differential
+Rear Sprin

W +Sleepr Cab
@l +Spring Clamp
W +Suspension
-l +Temp Sensor
B +Temperature System

. +testl

W +Transmission
-l +Truck
W +Truck Damain
- +Truck Product1
W +Truck Product 2
@l +TS Socket
W +Web Temp Service
Y

--ﬂ’ —Engm.e Mount : Engine Mount  » bdd Truck BDD

gy

|

Note that BlockProperty entities are created where blocks are associated.
(Composite aggregations are defined as parts on the parent block). This is
also displayed in the Package view

© 2015 PTC
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Model Based System Engineering

» Define System Blocks

£ @EF.

System
System Engineering
Engineer CFT

. Y
{ Define System Blocks |
1 1

——————1———————

Define Internal Blocks,
Ports and Item Flows
Define Constramt Blocks
and Parametnc Diagrams

Rewew System
Architecture Design

Generate Budget Report

MNew

Open IDL File
Toggle Compartrments

Show,/Hide Compartmertgs...

Start Link
End Link...
Add

Help
Links

Set

Tools

/
[

JL

references and associations can

Various properties such as
attribute values, parts,

be displayed or hidden

Autosize

Populate
Link Class
Unlink Class

Right click on a block and

select Show/Hide
Compartments

Open

3

Roll Up Contestval Features” arien i

Browse Class...

Ci

its to display

Report

L/'z

Choose what
information to display

© 2015 PTC
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Model Based System Engineering

» Define System Blocks

Zl+ oo+ 0o
@Q(? . EREEY KERTNATS X IR XN Select the
' VAR YD | Block Properties Attribute ;
Attribute menu
System can be added to "['BDD (Truck Domain) X | | Block Property and choose
ESyS_tem Engineering blocks to | Constraint Parametels _\ Block Property
ngineer CFT Capture || Constraint Property

attribute values

Enumeratien Literal

Flow Port
Flow Property
Full Port

- Interface Property

@ Click on the
] Define System Blocks [i Block that the
1 1 i i

_____1_______ attribute will be
added to

L

Proxy Port
Standard Port

@l b D

Name the property. It
is displayed in the
package hierarchy

and diagrams

Deﬂne Internal Blocks,
Ports and ltem Flows

4

s I 5,5 includes a

Define Constraint Blocks Optors. Bsting Type: model of common D---= *+Slecpr Cab
; : e B . -kl +5Spring Clamp
and Parametric Diagrams o e e Sl units that can Ml +Suspension
-3 Al Interface Blocks - i
S Qs \:';\ue ) be re-used E]- Temp Sensor

-l +Temperature System
Il jcci

I3 Al Value Types (Aray)
. -2 All Value Types (Basic Typs)
Review €0 Al Vaie Types (Deta Type) _l/

¥ § (Budget Profile: Value Types)

-7 Boolean (SysML Profile::Prmitive Value Types) -8 'We'sht : Real

7 Complex (SysML Profile::Blocks: Blocks) L B -Maximum Load : Real
--'§ Complex (SysML Profile: :Primitive Value Types) T W
- Integer (SysML Profile::Primitive Value Types) _ a -Sleeper Cab : Sleepr Cab
'Y kg (SysML Profile -S| Definitions--S| Value Types) - )

. m (SysML Profile::Sl Defintions: S| Value Types) -1 -Chassis : Chassis

- F N (SysML Profile::Sl Defintions::S| Value Types) =3 | -Drive Axle : Drive Axle
- Number (SysML Profile:: Primitive Value Types) | . a -Load Axel: Load Axle

-Load Bay : Load Bay
-Garage : Garage

- String {SysML Profile::Primitive Value Type: -
- § W (Budget Profile:-Value Types)
{23 All Value Types (Enumeration)
{23 Al Value Types (Sequence)
Select a data type for the
L=t attribute (Real primitive type
s— selected in image)

© 2015 PTC 84




Model Based System Engineering

» Define Internal Blocks, Ports and Item Flows

System
System Engineering
Engineer CFT

Define System Blocks

Define Internal Blocks,
Ports and ltem Flows

®;

ne Constraint Blocks
and Parametnc Diagrams

efi

ReV|ewS tem
Architecture Design

Define Interface Blocks

Interface blocks do not need to be
added to diagrams, so are created
directly in a package

Select a suitable package and
right click. Select New > SysML
> Structure > Interface Block

Block

Constraint Block

Flow Specification

Instance

—
-0 +1
(] +Activities N
A0+ Assets
{3 Start Link
3 +Dia End Link...
A0 +Re Synchronize IDL Element Names
[0 +Use
[ +Var Open IDL File
-§ i New 4 Package 3
-% +Fud = -
e +Ca Update All Profiles... Change Note
8 +Ca Diff With Other Model... Comment
]
=4, +Tr Remove from Package CanEs
2 +Dni
Scope To Package... Diagram L4
-2 +Logd
D +0p Links D DnC Profile 3
-2 +Unl] Report D IDL Profile 2
~fm+Usg o , Matrix/Table  »
201 +Softwe Find N SysML v Problem
i-4% +IDL_Ex T N
5.7 +IDL_Ex: Open b Rationale
(1 +Budged Merge Varizbility 4 Allocations  »
~-[&] +Graphi Applied Stereotypes D Atego 4 Behavior »
+Truck 2 General 3
B o Trock 1 Add To Favorites Ctrl+G
1 Packages Remave From Favorites  Ctrl+Shift+ G EequiEmen i
Structure 3
Items and Diagra Configuration Management 3
Traceability 3
lame Package Import/Export » —
* [Trucl s 3 ndo trl+ ocks:Day C... ProxyPort
B [Truck (Sy Und Ctrl+Z  PBlocks:Day C... ProxyP
n

Enter a name and specify options

Interface blocks are specialized
blocks that have no behaviors or
internal parts and are used to
type Proxy Ports (used in
Internal Block Diagrams)

© 2015 PTC

Use Cases ¥ Interface Block
)
I Model

E(Ploperlis of 'Engine Mount' j

General |Text | Options | Changes [ Stle [ kems [ InterfaceBlock |

I Engine Mount

Fullname:  Truck (SysML)::Blocks::Engine Mourt

Type: Interface Block

Last changed on/by: 08/01/201513:15:39 PTCNET“Pollerton

Visbiity: @ Public () Protected () Private

() Package )
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Model Based System Engineering

» Define Internal Blocks, Ports and Item Flows

— System
System Engineering
Engineer CFT

Define System Blocks

S S——

Define Internal Blocks, |
Ports and ltem Flows :

L o e o e e e e e e

Define Constraint Blocks
and Parametric Diagrams

Review System

Architecture Design

Capture more details on the
internal structure of each
block using an Internal
Block Diagram

Block Definition Diagrams (BDDs) show the
structure of the system functions. Internal Block
Diagrams (IBDs) look inside the blocks to define the
data/information/item flows and the ports

I Generate \itﬂepon

Mew

F | I Budget Item

Open IDL File

Toggle Compartments
Show/Hide Compartments...
Start Link

End Link...

Add

Help

Links

Set
Tools

SysML

'ﬁ Internal Block Diagram .,

, -

Parametric Diagram - \

ce [hanram

[Block] Truck [1] X rBDD (Truck Domain) X ]

Autosize / \
/ \

Right click on a block and
select New > SysML > Internal

Block Diagram

Define diagram
properties

© 2015 PTC

ﬂ .

I E —T—

rX Properties of '[Block] Truck [1]' 1

General |Texi |Changes | Style | ltems. | IrrtemalBlockDiaglam|

[Block] Truck [1]

Fullmame: Tk {SysML)::Blocks:: Truck: [Block] Truck: [1]

Page reference:  jhg

Intemal Block Diagram
S




Model Based System Engineering

» Define Internal Blocks, Ports and Item Flows

-

£ @EF.

System
System Engineering
Engineer CFT

Define System Blocks

Define Internal Blocks,
Ports and ltem Flows

aint Blocks
and Parametric Diagrams

@ Review System
Architecture Design

Add a Block Property

ibd [Block] Truck([1]

we -QQREF I DEB® Lo I LS
secTegy « o * i S S~
Options: Existing Type:
@ Existing Type -1 Al Valid Types A
-~ =-{Z1 All Blocks - }
BT W) i (Truck (SysML): Blocks) -
2 Untyped -l Budget Types (Budget Profile)
-] Cab (Truck (SysML): Blocks) V4
-l Chassis (Truck (SysML):Blocks) 4 y
. D Axel (Truck (SysML)::Assets: Drive fude) 2 I
T S O ——
[l Day Cab {Truck (SysML): Blocks) || -
B X i Properties of 'Day Cab'
Drive Input {Truck (SysML)::Assets::Drive Ade) e e -
-l ECU (Truck {SysML)::Activities) G ] -
L/ 7r 1l Envionment (Truck (SyeML):Biocks) ereral (ot | Setaios ]| Comecs, | S ] BockBmncty|
. Flange (Truck (SysML)::Assets::Load Awde)
/ /M Fuel (Truck (SysML)- Blocks) ‘l Day Cab
SG‘| ect B I O C k - Garage (Truck (SysML)::Blocks) —
-] L el (Truck (SysMIL)::Assets::Load Ade) Fullname: Dy Cab [Truck (SysMLY:Blocks:Day Cab - Truck (SysML)::Blocks: Truck
type Create M| Load (Truck (SysML):Blocks) & [Tk (3ysWL}-Blocks:Day fck (SyshIL]-Blocks:Truck]
suitable Block -l Load fode (Truck (SysML)::Blocks)
i K -] Load Bay {Truck (SysML): Blocks) | Type: Block Property
first if needed -l Long Chassis (Truck (SysML):Blocks) e .
. Mechanical Sub-system 1 (Truck (SysML): Activities)
-l Road (Truck (SysML):Blocks) =
View Options == ]
|
i [t 7] Show Name Docking Type
| Stereotypes
| 2] Show Full Name
| style
Show Type
. . [7) Show Multiplicity O tiOI’la” ShOW
Right click on n‘,fme fu”yname
the Block [E] Show &s Frame e r,nu|t| e ’
PI’O pel’ty and [7] Shaw Text As Floating Atachment < yp ! p y,
select View ~ etc.
Options
i [ ok ][ cancel ]| Apply
L

© 2015 PTC
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Model Based System Engineering

» Define Internal Blocks, Ports and Item Flows

g Ports are points at which external
- @Q? Define ports and connectors entities can connect to and interact
N A with a block in different or more
I Ensﬁéeer:i‘n \/ limited ways than connecting directly
Engineer gCFT 9 to the block itself. They are properties
with a type that specifies features

available to the external entities via
connectors to the ports

Define System Blocks

EE I8 EAE

T’roxy Port h

Define Constraint Blocks
and Parametric Diagrams

Add new Block

. l called Engine and
Review SyStem click on Proxy Connector

Architecture Design @ Port
Ports and flows can be used to _
8

enable design of modular,
reusable blocks with clearly
defined ways of connecting and
interacting with their context of
use

© 2015 PTC 8



Model Based System Engineering

» Define Internal Blocks, Ports and Item Flows

Select type for new port —we

lick h fth will use the Engine Mount
- @qa el i e_:top edge of the Interface Block created earlier
"K VARV Y Engine block
i) .
' System e - .
Esn}:_:jsi:]eerEr Engineering Options: Existing Type:
CFT : :
@ Existing Type =+ Al Valid Types N
A =-{ All Interface Blocks
Ofawlypa T B Bay Foing (Truck (SysML: Blocks)
© Untyped | 1 L @ Bay Holder (Truck (SysML)::Blocks)
----- u Cab Fixing (Truck (Sy=ML)::Blocks)

----- u Cab to Chassis (Truck (SysML):Blocks)
EBl [=:h et (Toy- ol Blocloe

E I [ Engine Mount (Truck (Sysh

o

Define System Blocks |1 (| I S Bl Rear Spring (Truck (SysML)::Blocks)
----- @ Spring Clamp (Truck (SysML}::Blocks)
----- u TS Sochket (Truck (SysML):Blocks)
-3 Recently Used

({27 Package Hierarchy

H-{_1] On Active Diagram

S S——

Define Internal Blocks, |
Ports and ltem Flows :

L o e o e e e e e e

Define Constraint Blocks
and Parametric Diagrams

Review System

Can also create a new
Interface Block type

Select Type ] )@
Cptions: New Type:

o Edaiing Tupe Type: [l Interface Block | Port definitions may be driven by system
Name:  Engine Ar Mourt requirements (e.g. communication
network protocols)

Architecture Design

© 2015 PTC 89



Model Based System Engineering

» Define Internal Blocks, Ports and Item Flows
§)ELS s

System
Engineering
CEil

<, f’ Properties of )

General | Text | Options | Data Type | Changes | Style | tems | ProxyPort |

System
Engineer

Define System Blocks

—E) Engine Mount

Full name: < Truck Engine.Engine Mount

Type: ProxyPort
Last changed on/by: 11/01/2015 15:47.44 PTCNET Polletton
Right click on the port and Visibilty: ) Public () Protected @ Private () Package y
select View Options
and Parametric Diagrams \ /_
Review System . repositioned
Architecture Design [Pt I chowneme Docking Type A P
Stereotypes
Style

— — ~
Show Type - ~\ . Proxys

[T] Shoms Multiplicity [¥] Show Derived Direction . Enging Mount
Show Default Walue
J
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Model Based System Engineering

» Define Internal Blocks, Ports and Item Flows

System
Engineer

Engineering
CE

Define System Blocks

and Parametric Diagrams

Review System
Architecture Design

Add a port to the Chassis
block and then add a
Shallow Connector

: Properties of 'Connector’

General | Tet | Options | Start Role | End Role | Changes | Style | tems | Connector

o Connector

Fullname:  Connector [Chassis Fixing - Engine Mount]

Type: Caonnector

[ Shallow Connector h

Ports and connectors represent an interface between
system entities. This concept is explained further in a
later procedure.

© 2015 PTC
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Model Based System Engineering

» Define Internal Blocks, Ports and Item Flows ____

'; @@‘? Complete definition of internal

— System blocks, ports and item flows
System Engineering
Engineer CFT

Define Constraint Blocks
and Parametric Diagrams

Review System
Architecture Design

Define the l/

data/information/item e T e
flows between the system S
blocks el
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Model Based System Engineering

» Define Constraint Blocks and Parametric Diagrams

s (@ {
%T ; e VAR A’ Constraint Blocks can be

System p optionally defined within BDDs to

Engineering \ represent system properties such

CFT as cost, power output, weight, flow
rate etc.

System
Engineer

Parametric diagrams are used to

Define System Blocks define how the parameters for the

bkp fc constraint relate to specific value
l «constraint» properties of the sub-system block
FlowConstraint

Define Internal Blocks, constraintParameters
Ports and ltem Flows «ConstraintParameters demand : Real
«ConstraintParameters flowrate : Real

«ConstraintParameter» pressure - Real

: . constraints
g’ Define Constraint Blocks [ {flowrate=pressure(4*demand)}
: and Parametric Diagrams ]
1
Review System
Architecture Design demand : Real

- pressure - Real
flowrate - Real fc - Flokebnstraint O e e
constraints
@ {flowrate=pressure(4*demand}}
___d
Parametric diagrams and
constraint block should be
used to capture non-functional
requirements
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Model Based System Engineering

» Define Constraint Blocks and Parametric Diagrams

A @@a Complete definitions of —
,‘h , ystem any constraints and

System Engineering parametric diagrams

Engineer CFT

d -
flowrate - Real ] e BT injectorDemand - Real

Max Acceleration | wrequirements
averifyn Acceleration
l
byn

Define System Blocks

. lcap
Define Internal Blocks, Y
CERELE LD wconstraints «constraints <constraints
POI‘tS and Item FlOWS CapacityEquation RollingFrictionEquation FuelEfficiencyEquation StraightLineVehicleDynamics
Vﬁ?rmrlalmPar ;
e :
ve «constraint» «constraints aconstraints «constraints
i ) " l PayloadEquation TotalWeight ‘ AeroDragEquation RegenBrakeEfiiciencyEquation
| and Parametric Diagrams ] it
. o:ustrlaimParamelers
ace: Acce
o g Cd:Real
Review Svstem Co-ordinate with o
i B performance and quality ine:Rea
Architecture Design - Woig

processes when defining whipowr-HorsePwr
constraints x: Dist I
&W &S l‘a lzcc

«Constraints «Congraints «COMENr aints scongraints
PowerEquation PositionEquation VelocityEquation AccelerationEquation
il il constrai i 5
Cd:Real delta-t:Time a:Accel a:Accel
Cf:Real v Vel delta-t: Time delta-t: Time
i-Real x:Dist v el tp : Hor sePwr
tp: HorsePwr tw : Weight
tw : Weight
v Vel
whipwr:HarsePwr
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Model Based System Engineering

» Review System Architecture Design

System
Engineering
CFT Coordinate with related
processes and identify any
relevant existing information:
Automated System Design
Review, Verification and
Validation, Test Management

System
Engineer

Define System Blocks

Define Internal Blocks,
Ports and ltem Flows

[y v—r— = — =
T e e ook b
SO Ot B s ViRt U et 8 vy

Analyze and review
system model and
system architecture

Define Constraint Blocks
and Parametric Diagrams

_____ ) —

@ Review System
Architecture Design

Update system
model if needed
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Model Based System Engineering Best Practice

Procedure

» Allocate Architecture

System
Engineer

* Objectives
— Define traceability from requirements to system architecture. Plan
physical architecture

Engineering
CE

® * Role
Plan Systems — System Engineer

Engineering Initiative

| — Cross-functional Team

Define & Analyze
System Context
| * Qutputs
Analyze Requirements — Associations from Requirements to System Architecture Model

I — Physical Architecture plans

Design Use Cases

Design Functional View

Design Architecture
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Model Based System Engineering

» Allocate Architecture

System

] Engineering
Engineer

CET

Plan Systems
Engineering Initiative

Define & Analyze
System Context

Analyze Requirements

Design Use Cases

Design Functional View

Design Architecture

Allocate System Behaviorf
to System Structure

@ Map System
Architecture to
Mechanical, Electrical

and Software Entities

|

Plan Physical
Architecture Alternatives

!

Analyze, Review and
Refine Architecture
Alternatives

v

Select Preferred
Physical Architecture

© 2015 PTC
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Model Based System Engineering

» Link System Behavior to System Structure

System
System Engineering
Engineer CFT

Allocate System Behavior:
to System Structure [
1

h—————i———————

Map System
Architecture to
Mechanical, Electrical
and Software Entities

@ Plan Physical
Architecture Alternatives

@ Analyze, Review and
Refine Architecture

Alternatives

9

[ et |

Select Preferred

Physical Architecture

Allocation can be used to link system
behavior to system structure, in this case
linking the Operate Truck Sequence diagram
with the Truck Block Definition Diagram

.. +Instance? M.ong Chassis
--D +Drive

@) +Load

BCD +Operate Truck

L

Start Link

cab

If over night trip
Driver sleeps in sleeper ca
Drriver drives next day

end alt

ay

-0 +Refuling

{-

-] +Variation e As
M- +Driver

G0 +Sleep H Link...
-2 +Unload "

2.3

Right click on a
sequence
diagram and
select Start
Link...

Right click on the block definition diagram
to be linked and select End Link...

TReyunen viiayrarn . X
-.[7%| +Requirements Diagram 2 ‘ ‘ ” If over night trip
+Truck BDfg Dt !
_____ 90+ Use Cas | Start Link
_____ % = +LUce Casel End Link...
----- # +Variant D elp
----- g +Variant D Save As
..... &h +Variant H

i-[1 +Requirement] LEEr

Select Allocated To as the

Artisan Studio ?

relationship and click OK [——

Quick Links
Start ttem

Cperate
Operate Truck (Truck (SysML)::Use Cases)

L

Relationship

[Alocated To

End ftem

Fw | Truck BDD
W W | Diagrams (Truck (Sy=sML))
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Model Based System Engineering

» Link Requirements to System Architecture

System
System Engineering
Engineer CFT

IIocate System Behaviorf
to System Structure [
1

h—————i———————

Map System
Architecture to
Mechanical, Electrical
and Software Entities

@ Plan Physical
Architecture Alternatives

@ Analyze, Review and
Refine Architecture
Alternatives

Select Preferred

Physical Architecture

[ et |

A note can be added to the
Sequence Diagram to indicate
the relationship

: Properties of ‘Truck BDD' | njwes - @& &\ AEN[9] [R] = L34 e e BB
— —
= =
General | Tet | Ch t Block Definition Di Allocated I
| Eyl I I ang&BISter Iemsl o an agmml ro—
Operate Truck I":I
Tag Definition Name  Tag Value ﬁ
allocatedFrom Operate ' M 1
allocatedTo Driver loads the load bay r Load H
Driver drives the truck from the : T
A cab | :
If aver night trip : 1
/ Driver gleeps in sleeper cab T :
Drriver drives next day : T
This allocation can be seen in the end it ! :
Properties of the linked items Driver nloads the load bay i Unload '
' 1 !
I
bdd Engineering Allocation
Software designs
can also be allocated
to system blocks
Software Sub-system (UML) I
zallocates
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Model Based System Engineering

» Link Requirements to System Architecture

System
System Engineering
Engineer CFT

llocate System Behaviorfs
! to System Structure

h—————i———————

Map System
Architecture to
Mechanical, Electrical
and Software Entities

Plan Physical
Architecture Alternatives

Analyze, Review and
Refine Architecture
Alternatives

Select Preferred
Physical Architecture

Review results to identify

Navigate model relationships to view
traceability from blocks back to requirements

sequence diagram

Nfen DL File

Show/Hide Compartments.
Start Link

End Link...

BayFixing | | A4¢ D

Help
Links

= Right click on

muse | block and select
Delete Redefinition from Model Report > Usage
Delete Top Level Definition from W

Roll Up
Roll Up Features

Connector

Populate

Autosize

Report
Find

Open

Merge
Annlied Sterentvn

i Ttems and Diagrams which use Load Bay.

Mame

Truck (SyshL):Blocks: TruckJBD (Truck)
.Truck (SysMLj :Blocks:Truck Product 1.[Block] Truck Productl [1]

Type
InternalBlockDiagram

InternalBlockDiagram

InternalBlockDiagram

EH Truck (SysMLj:Use Cases,Operate Truck. Operate

Object Sequence Diagram

Association
BlockPronert

Associates [Truck - Load Bay]
_nl nad Bav [Truck (Swsh V:Blocks: | nad Bav - Truck (Swshl1:RBloc

Double click to open
sequence diagram

o

Operate Truck il
_Daycan |
e | 1 ]
Driver loads the load bay . Toad Pl . ! '
Driver drives the truck from the 7 : i Pl .
cab ' | ! | 1
] 1
If over night trip ' ! ' [ !
1 L Dl
Driver sieeps in sleeper cab Py
p: pei r ! | N Sleep n
Driver drives next day h T Lt}
1 Drive iy 1
end ait . | ! " 1
. ! I '
Driver unloads the load bay f Unioad Pl ' i h
1 Ll 1
1 ' . | '
u ' ! '

L) " - I%
=Operate Trur*
&-—7‘ how/Hide Compartments... LoadR
! sasistia Add . . . g
oriver oads o Took Right click on diagram title
Drtver drbes tf | Populate and select Find > In
cab T . .
Fovermontr | Relationship Browser
Open
Driver sl .
Driver dril Rernove from Package T
1
end alt Scope To Package... . !
Driver unloads| Links » Wﬂ- '
1
Report » [ h
L
Find » ]| 10 Blocks Browser
Merge In Constraint Blocks Browser
Applied Stereotypes » In DnC Elements Browser
All
IE Add To Faverites Ctrl+G In IDL Elements Browser
Remeve From Faverites  Ctrl+ Shift+G In Ports and Flows Browser
vy Undo Ctri+Z In Requirements Browser
By Copy CtrleC In Requirements (Extensions) Browser
B Paste Ctri=V In Asset Profile Browser
o] paste stye In Package Browser
o Delete Del In Part Browser
R In Dictionary Browser
ename
Dot o Mol In Relationships Browser I
T Dragram

© 2015 PTC

Use case will be highlighted in Relationship
browser. Expand and select Depends On
folder to view linked requirements

E|C) Operate Truck
-] Dependents
-1 Depends On

D Parents
{:I Children
{:I Actors
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Model Based System Engineering

» Map System Architecture to Mechanical, Electrical and Software Entities

System
System Engineering
Engineer CET

Allocate System Behavior}
to System Structure

Map System
Architecture to
Mechanical, Electrical
and Software Entities

Plan Physical
Architecture Alternatives

!

Analyze, Review and
Refine Architecture
Alternatives

v

Select Preferred
Physical Architecture

Determine sub-systems or parts
that require mechanical, electrical
or software components

Preliminary Design
Structure

—_—
—
—_—_——

S ——— e — — T

(0) ECU software
N ECAD
@ Model

Executables

ECU block will require a physical casing,
electrical circuits and embedded software

© 2015 PTC
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Model Based System Engineering

» Map System Architecture to Mechanical, Electrical and Software Entities

: g Preliminary PDMLink
s @@0} Use the system Product Structure
i block structure
System Enaﬁg:i‘ng to derive and v ﬁ Truck Assembly
Engineer CET plan the physical g
structure. Note ,4"
that this is a - .
manual step N, oree G e e = = j ___-——D—%Chasss
IIocate System Behaviorf | :
to System Structure = @ Suspension

Map System
Architecture to
Mechanical, Electrical
and Software Entities

Plan Physical
Architecture Alternatives

!

Analyze, Review and
Refine Architecture
Alternatives

v

Select Preferred
Physical Architecture
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Model Based System Engineering

» Map System Architecture to Mechanical, Electrical and Software Entities

£ ERS)

L System Block properties can be mapped to attributes on the
Sys_tem Engineering physical models (Parts, CAD Documents or ECAD data)
Engineer CFT

| L .

ﬁ Truck Assembly

Allocate System Behavior}
to System Structure @
Map System | '
Architecture to Powertrain
Mechanical, Electrical
and Software Entities _ﬁ Engine
Plan Physical — oLy Attributes:
Architecture Alternatives
Power Output
‘ Capacity
Analyze, Review and Compression Ratio
Refine Architecture CO2 Output
Alternatives i
Select Preferred
Physical Architecture
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Model Based System Engineering

» Map System Architecture to Mechanical, Electrical and Software Entities

Attributes, operations,

System . .
System Eng)i/neering constraints and interfaces
Engineer CET in the system model can

all drive software design

e

UML packages and class models can be
created in Modeler and code can be
generated from the models. Lifecycle
Manager can be used to manage software
source code (Integrated Software Mgmt)

Allocate System Behavior}
to System Structure

Map System
Architecture to
Mechanical, Electrical
and Software Entities

i\ ]
HEA N 4‘—‘ HSUVInterfaces [ pen
; PN -
Plan Physlcal ' &, [DeirerFonerBehavior ‘:

Architecture Alternatives S

; e S
: :
i s

Jeimperte
'

Analyze, Review and : R
Refine Architecture — -

Alternatives ;Em' . = :

Select Preferred
Physical Architecture

LIH |
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Model Based System Engineering

» Map System Architecture to Mechanical, Electrical and Software Entities

=3

1

System
Engineer

N

System
Engineering
CEil

Allocate System Behavior}
to System Structure

Map System
Architecture to
Mechanical, Electrical
and Software Entities

Plan Physical
Architecture Alternatives

!

Analyze, Review and
Refine Architecture
Alternatives

v

Select Preferred
Physical Architecture

Identify interfaces by reviewing associations
in the structure model

S

Review ports and
connectors on
IBDs to identify

potential interfaces

Review BDDs and identify
relationships between blocks
that require an interface to be

defined and managed
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Model Based System Engineering

» Map System Architecture to Mechanical, Electrical and Software Entities

Plan the interfaces needed in the physical INTERFACE SPECIFICATION PTC

System architecture and related design models
System 3 g Interface Number:  GC901-200-200
b ] Engineering Description: TRANSMISSION TO ENGINE
Engineer CE V Revision History
. . Rev] Dete  Change# Description of Change
Preliminary Design Al
Structure o Nirer T —
GC201-0000-001 T iSSi
GC202-0000-005 Go-art Engine =
@ ﬁ Truck Assembly L l Truokasm Attachment 4M8bd&lomurew:=: bracket
~ ~—  _ _—— 1

Allocate System Behavior

Define and agree interface
to System Structure

specifications and assign ownership

Map System
Architecture to [
Mechanical, Electrical
and Software Entities

Plan the realization of interfaces in
design models (Refer to Interface
Definition and Mgmt best practice)

—_—
_—

Attachment/ -
Plan Physical _Assembly 109_1001_PTC ASM
; : interface (Engine s s @ 109-1001K01
— I - 109-1001K01_P16_SKEL.PRT]
Architecture Alternatives > Transmission —0e ECU e )-8 7 ASM_RGHT
‘ and ECU) — 27 ASM_TOP
— 7 ASM_FRONT

Analyze, Review and
Refine Architecture
Alternatives

%ASM_DEF_CSYS
+ Insert Here

v

Select Preferred
Physical Architecture

Electro-

(ECU to
PCB)

Transfer of power interface

- -
/
mechanical {é} —————
interface

(Engine > Transmission)

© 2015 PTC
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Model Based System Engineering

» Plan Physical Architecture Alternatives

™ @Q<? Consider architecture alternatives
f%-—? \ VAR VD

to ensure all options are evaluated
System ﬁ
System Engineering N/
Engineer CFT il

IIocate System Behaviorf | {%} _qc}} '@}

to System Structure

Map System _@
Architecture to l—@ I_@
Mechanical, Electrical

and Software Entities _@ {?};
{gé

Analyze, Review and

Refine Architecture Also consider product options and
Alternatives variants —refer to the Model Based
* Product Line Engineering best practice
for more information
Select Preferred

Physical Architecture
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Model Based System Engineering

» Analyze, Review and Refine Architecture Alternatives

Review and refine architecture alternatives with CFT

System
e Engineering N
Engineer CFT _
&
—i
) e
Allocate System Behaviorf o
to System Structure
i .03
Map System ——

Architecture to
Mechanical, Electrical
and Software Entities

}

Plan Physical
Architecture Alternatives
Axle_End_Assembly Design Review T - Ry R T
— Details o Ao aua - - = =
Analyze, Review and . e — e = 5 - 2 “
Refine Architecture REHEHE Ui | SeIEn? T i = il
Alternatives Design Review best " =
practice for more = e —
information |—> s
Select Preferred ] i — -
Physical Architecture s

5 Attachments (0 objectd

[z oo ncn
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Model Based System Engineering

» Select Preferred Physical Architecture

3 System

stem H P

En};ineer Enggﬁ.?“ng CFT will then select the optimum
physical architecture to best meet the

system requirements

o

Allocate System Behavior
to System Structure

Map System
Architecture to
Mechanical, Electrical
and Software Entities

}

Plan Physical
Architecture Alternatives

!

Analyze, Review and
Refine Architecture
Alternatives

Select Preferred
Physical Architecture
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